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1 Introduction to Siebel CRM On 
Demand Integration Pack for 
Oracle E-Business Suite
Contacting Technical Support
The CRM On Demand Training and Support Center is a single access point to a wide range of help, 
training, and support resources that help you get more out of Siebel CRM On Demand. It provides 
24/7 access to create and modify service requests as well as display system status alerts and 
notifications. To access the Training & Support Center, log into Siebel CRM On Demand (http://
www.oracle.com/crmondemand/index.html) and click on the Customer Care link.

TTY Access to Oracle Support Services
Oracle provides dedicated Text Telephone (TTY) access to Oracle Support Services within the United 
States of America 24 hours a day, seven days a week. For TTY support, call 800.446.2398.

Documentation Accessibility
Our goal is to make Oracle products, services, and supporting documentation accessible, with good 
usability, to the disabled community. To that end, our documentation includes features that make 
information available to users of assistive technology. This documentation is available in HTML 
format, and contains markup to facilitate access by the disabled community. Accessibility standards 
will continue to evolve over time, and Oracle is actively engaged with other market-leading 
technology vendors to address technical obstacles so that our documentation can be accessible to 
all of our customers. For more information, visit the Oracle Accessibility Program Web site at http:/
/www.oracle.com/accessibility/.

Accessibility of Code Examples in Documentation
Screen readers might not always correctly read the code examples in this document. The conventions 
for writing code require that closing braces should appear on an otherwise empty line; however, some 
screen readers may not always read a line of text that consists solely of a bracket or brace.

Accessibility of Links to External Web Sites in 
Documentation
This documentation may contain links to the Web sites of other companies or organizations that 
Oracle does not own or control. Oracle neither evaluates nor makes any representations regarding 
the accessibility of these Web sites.
Siebel CRM On Demand Integration Pack for Oracle E-Business Suite
Implementation Guide
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Introduction to Siebel CRM On Demand Integration Pack for Oracle E-Business Suite 
■ Structure
Structure
1 Introduction to Siebel CRM On Demand Integration Pack for Oracle E-Business Suite

2 Siebel CRM On Demand Integration Pack for Oracle E-Business Suite Environment

3 About Integrating Customer Data, Products, and Quotes

4 Installing and Configuring the Applications

5 Initial Bulk Loading of Customer, Contact, and Product Data

6 Troubleshooting

Related Documents
For more information, see the following documents:

■ Oracle Customers Online User Guide

■ Oracle Customers Online Implementation Guide

■ Oracle Quoting Implementation Guide

■ Oracle Quoting User Guide

■ Oracle Trading Community Architecture User Guide

■ Oracle Trading Community Architecture Administration Guide

■ Oracle Trading Community Technical Implementation Guide

■ DQM Administration Guide

■ Siebel CRM On Demand Online Help

Do Not Use Database Tools to Modify 
Oracle Applications Data
Oracle strongly recommends that you never use SQL*Plus, Oracle Data Browser, database triggers, 
or any other tool to modify Oracle Applications data unless otherwise instructed.

Oracle provides powerful tools you can use to create, store, change, retrieve, and maintain 
information in an Oracle database. But if you use Oracle tools such as SQL*Plus to modify Oracle 
Applications data, you risk destroying the integrity of your data, and you lose the ability to audit 
changes to your data.

Because Oracle Applications tables are interrelated, any change that you make using an Oracle 
Applications form can update many tables at once. But when you modify Oracle Applications data 
using anything other than Oracle Applications, you can change a row in one table without making 
the corresponding changes in the related tables. If your tables are out of synchronization with each 
other, you risk retrieving erroneous information, and you risk unpredictable results throughout 
Oracle Applications.
Siebel CRM On Demand Integration Pack for Oracle E-Business Suite 
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Introduction to Siebel CRM On Demand Integration Pack for Oracle E-Business Suite
■ Glossary
When you use Oracle Applications to modify your data, Oracle Applications automatically checks that 
your changes are valid. Oracle Applications also keeps track of who changes information. If you enter 
information into database tables using database tools, you can store invalid information. You also 
lose the ability to track who has changed your information because SQL*Plus and other database 
tools do not keep a record of changes.

Glossary
360° View. A screen within the Oracle Customer Online application that displays a comprehensive 
list of contracts, credit information, email interactions, invoices, orders, quotes, payments, projects, 
and service requests for a given customer.

Account. In Oracle an account describes the specific attributes of a party that are relevant to the 
selling relationship that the implementing organization has established with a party. An account in 
Oracle cannot exist by itself without a party. It can be associated with an individual (person) or a 
company (organization). In Siebel CRM On Demand an account describes an organizational customer.

BES. Oracle Business Event System based on Oracle Workflow.

BOM. Bill of materials—defines the components and hierarchy of a product.

BPEL. Business Processes Execution Language, a standards-based extensible language.

Catalog Category. A category is a logical classification of items that have similar characteristics.

Category Set. Category sets can be used as a means of developing custom lists of items, which 
you can report and sort. A category set is a distinct grouping scheme and consists of categories.

CBM. The created_by_module column in Trading Community Architecture tables.

CDH. Oracle Customer Data Hub.

Contact. In Oracle E-Business Suite 11i, a contact describes a specific relationship between two 
parties, more specifically between an Organization and a Person party, which is also called an 
Organization Contact. The Organization Contact can also be associated with a Customer account in 
Oracle, which is then called an account contact. In Siebel CRM On Demand a contact describes an 
individual customer who might or might not be related to an account (Organization customer) or 
another contact (individual customer).

Customer. In Oracle E-Business Suite 11i a customer is defined as a party with whom the 
implementing organization has established a selling relationship. All relevant information of the 
specific selling relationship with a party is modeled in the account layer entities in Oracle, whereas 
all the base information like name, address information, contact points are modeled in the party layer 
entities. A customer in Oracle can be an individual (person) in the case of a Business-to-Consumer 
relationship, or a company (organization) in the case of a Business-to-Business relationship. In 
Siebel CRM On Demand a customer can be either modeled as an account or as a contact. An account 
in Siebel CRM On Demand is the equivalent of an organization party and account in Oracle, and a 
contact is the equivalent of a person party and account in Oracle.

FMW. Fusion Middleware.

Install Base. An Oracle record of the goods and services that a customer owns.
Siebel CRM On Demand Integration Pack for Oracle E-Business Suite
Implementation Guide
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Introduction to Siebel CRM On Demand Integration Pack for Oracle E-Business Suite 
■ Glossary
Item. A product or service that is manufactured or sold. Items can be used to represent grouping 
assemblies or placeholders such as phantoms.

Middleware. Integration software that is used to connect applications, such as Webmethods.

Oracle EBS. Oracle E-Business Suite applications.

Order Management. Refers to organizations as warehouses on all Order Management windows 
and reports.

Organization. A business unit, such as a plant, warehouse, division, department, and so on.

OS. The orig_system column in Trading Community Architecture table.

OWB. Oracle Warehouse Builder.

Party. In the Oracle E-Business Suite 11i, more specifically in the Trading Community Architecture, 
a party is defined as any individual or organization with whom the implementing organization can do 
business. A party in Oracle Trading Community Architecture could be a customer (for example, in the 
case of a selling relationship), a vendor, or an employee. The same party can have multiple such 
roles within Oracle E-Business Suite 11i. In the context of this integration solution only those parties 
in Oracle E-Business Suite 11i that represent customer data are addressed. The concept of a party 
does not exist in Siebel CRM On Demand.

SOA. Service Oriented Architecture.

SCOD. Siebel CRM On Demand application.

TCA. Trading Community Architecture.
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2 Siebel CRM On Demand 
Integration Pack for Oracle 
E-Business Suite Environment
This chapter describes the environment needed for Siebel CRM On Demand Integration Pack for 
Oracle E-Business Suite. It contains the following information:

■ About Siebel CRM On Demand Integration Pack for Oracle E-Business Suite on page 11

■ Software Requirements on page 13

■ Data Quality on page 14

■ Cross-References on page 14

■ Language Support on page 15

About Siebel CRM On Demand 
Integration Pack for Oracle E-Business 
Suite
The Siebel CRM On Demand Integration Pack for Oracle E-Business Suite integrates account, 
customer, order, and quote information between Siebel CRM On Demand and Oracle E-Business 
Suite. The functionality provided by this integration includes:

■ Creating accounts with Data Quality Management

■ Creating contacts with Data Quality Management

■ Enabling Siebel CRM On Demand opportunity to Oracle E-Business Suite quote conversion 
business process

■ Synchronizing customer data from Oracle E-Business Suite to Siebel CRM On Demand

■ Synchronizing customer data from Siebel CRM On Demand to Oracle E-Business Suite

■ Synchronizing product data from Oracle E-Business Suite to Siebel CRM On Demand
Siebel CRM On Demand Integration Pack for Oracle E-Business Suite
Implementation Guide
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Siebel CRM On Demand Integration Pack for Oracle E-Business Suite Environment 
■ About Siebel CRM On Demand Integration Pack for Oracle E-Business Suite
Figure 1 shows an overview of the components of the integration.

Figure 1. Integration Summary
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Siebel CRM On Demand Integration Pack for Oracle E-Business Suite Environment
■ Software Requirements
Oracle E-Business Suite data objects and Siebel data objects do not have an exact 1:1 equivalence 
for every field. To convert the data appropriately, the Siebel CRM On Demand Integration Pack for 
Oracle E-Business Suite uses Fusion Middleware (FMW) and Oracle Business Process Execution 
Language BPEL). Figure 2 shows this architecture.

FMW and BPEL are used in the real-time updates between Oracle E-Business Suite and Siebel CRM 
On Demand. However, before these products can be used together, a one-time initial data load is 
needed to synchronize Siebel CRM On Demand with Oracle E-Business Suite. For more information 
about initial loading of data, see Chapter 4, “Initial Bulk Loading of Customer, Contact, and Product 
Data.”

Software Requirements
The Siebel CRM On Demand Integration Pack for Oracle E-Business Suite requires the following 
versions:

■ Oracle 10.1.3.1 Application Server Enterprise Edition

■ Oracle E-Business Suite, 11.5.10 CU2

■ Oracle JDeveloper 10.1.3.1 (upgraded to the latest patch)

■ Oracle SOA Suite 10.1.3.1 (upgraded to the latest patch)

■ Oracle Warehouse Builder 10gR2 (Optional)

Figure 2. Integration Architecture
Siebel CRM On Demand Integration Pack for Oracle E-Business Suite
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Siebel CRM On Demand Integration Pack for Oracle E-Business Suite Environment 
■ Data Quality
Data Quality
You can choose to enable the standard Oracle Data Quality Management (DQM) duplicate check when 
creating new customer data. A profile option within Oracle E-Business Suite can control this 
functionality (see Table 8 on page 46).

Within the process flow that creates the new Siebel CRM On Demand customer in Oracle E-Business 
Suite and later also in Siebel CRM On Demand, the Oracle Data Quality Management (DQM) Search 
Service can be called to identify possible duplicate customers during data entry and before the 
customer is created in Oracle E-Business Suite. The user can control whether the DQM Search 
Service is called from the process flow using a standard profile option in Oracle E-Business Suite (see 
Table 8 on page 46).

If you choose to check for duplicates in Oracle E-Business Suite and if the Oracle DQM Search Service 
returns one or more possible duplicate customer records, the possible duplicate customer records 
are displayed to the user in the user interface. The user can then choose to either pick one of the 
existing customers (in case the newly entered customer is a true duplicate), or create the new 
customer record in Oracle E-Business Suite (in case the newly created customer is not a duplicate). 
If the user chooses to pick a customer that already exists in Oracle E-Business Suite, the process 
orchestration flow retrieves the customer record from Oracle E-Business Suite and creates the 
customer record in Siebel CRM On Demand. This flow assumes that the user has already executed a 
duplicate search within Siebel CRM On Demand before entering into the Create Account/Contact 
transaction.

Cross-References
To support ongoing customer data synchronization between Oracle E-Business Suite and Siebel CRM 
On Demand, a cross-reference of the unique identifiers of customer data is maintained in Siebel CRM 
On Demand. The entities that are cross-referenced on the Siebel side are account, address, and 
contact, which correspond to organization, party site and an organization contact in Oracle 
E-Business Suite.

For newly created customer records in Oracle E-Business Suite that need to be synchronized with 
Siebel CRM On Demand, Oracle E-Business Suite publishes the Oracle unique identifiers, which may 
be mapped to the External ID attribute of the appropriate entity in Siebel CRM On Demand to 
establish the cross-references within Siebel CRM On Demand.

For updated customer records that need to be synchronized with Siebel CRM On Demand, Oracle 
publishes the Oracle unique identifiers. The Siebel CRM On Demand Web Service interfaces are able 
to uniquely identify the records in Siebel CRM On Demand that need to be updated.

Oracle does not store the Siebel CRM On Demand unique identifier of the customer record.
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Siebel CRM On Demand Integration Pack for Oracle E-Business Suite Environment
■ Language Support
Language Support
Table 1 lists the languages supported for databases as part of this integration pack.

Base the product data synchronization on the Siebel CRM On Demand company's default language.

Table 1. Supported Languages for Siebel CRM On Demand Integration Pack for Oracle E-Business 
Suite

Language Character Set

Chinese (Simplified) ZHS16GBK

German WE8MSWIN1252

English-British WE8MSWIN1252

English-American WE8MSWIN1252

Spanish WE8MSWIN1252

French WE8MSWIN1252

Italian WE8MSWIN1252

Japanese JA16SJIS

Korean KO16MSWIN949

Portuguese WE8MSWIN1252
Siebel CRM On Demand Integration Pack for Oracle E-Business Suite
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Siebel CRM On Demand Integration Pack for Oracle E-Business Suite Environment 
■ Language Support
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3 Installing and Configuring the 
Applications
This chapter describes how to install and configure the Siebel CRM On Demand Integration Pack for 
Oracle E-Business Suite. It also describes how to configure the Oracle E-Business Suite and Siebel 
CRM On Demand to work with Siebel CRM On Demand Integration Pack for Oracle E-Business Suite. 
This chapter contains the following sections:

■ Process of Installing Components on page 17

■ Configuring Components on page 21

■ Process of Configuring the Oracle E-Business Suite Environment on page 41

■ Process of Configuring the Siebel CRM On Demand Environment on page 50

■ About Using Customized Fields on page 58

Process of Installing Components
Complete the following tasks to install the components for Siebel CRM On Demand Integration Pack 
for Oracle E-Business Suite. These tasks must be completed in the specific order listed:

1 Downloading Required Software for Installation on page 17

2 Installing Fusion Middleware Software on page 18

3 Installing Oracle E-Business Suite Patches on page 18

4 Installing Fusion Middleware and JDeveloper Patches on page 20

5 Installing and Deploying Siebel CRM On Demand Integration Pack for Oracle E-Business Suite on 
page 21

Downloading Required Software for Installation
This media pack contains the necessary files to support integration between Oracle E-Business Suite 
and Siebel CRM On Demand. Download these files from http://edelivery.oracle.com by choosing 
Oracle Application Integration Architecture from the Product Pack drop-down menu and choosing the 
platform to be used for your SOA Suite installation.

Download the following files:

1 Siebel CRM On Demand Integration Pack for Oracle E-Business Suite, v1.1, Implementation 
Guide (Documentation_ODIPv1.1.zip)

2 Oracle Database 10g Release 2 (10.2.0.1) (file name(s) and count vary by platform)

3 Oracle Database 10g Release 2 Patches (DB_Patches_AIAv1.0.zip)

4 Oracle SOA Suite 10g (10.1.3.1.0) (file name(s) and count vary by platform)
Siebel CRM On Demand Integration Pack for Oracle E-Business Suite
Implementation Guide
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Installing and Configuring the Applications ■ Process of Installing Components
5 Siebel CRM On Demand Integration Pack for Oracle E-Business Suite, Fusion Middleware Patches 
(FMW_Patches_AIAv1.0.zip)

6 Siebel CRM On Demand Integration Pack for Oracle E-Business Suite, E-Business Suite Patches 
(EBS_Patches_AIAv1.1.tar.gz)

7 Siebel CRM On Demand Integration Pack for Oracle E-Business Suite, v1.1, 
(SEBLODIntegPkEBSv1.1.zip)

Installing Fusion Middleware Software
Install the following Fusion Middleware components:

1 Oracle Database 10g Release 2 (10.2.0.1) Enterprise Edition. 
Download and install the database only if you do not already have an Oracle 10.2.0.2 (or higher) 
database instance available for the SOA Suite to access. For information on installing Oracle 
Database, refer to the Oracle Technology Network. Oracle Technology Network link has the 
following URL:
http://www.oracle.com/technology/documentation/index.html
After installation, apply the appropriate patch from DB_Patches_AIAv1.0.zip (choose the patch 
appropriate to the operating system that your database is installed on.) This patch brings the 
database up to required version 10.2.0.2.

2 SOA Suite 10g10.1.3.1
For information on installing Oracle SOA Suite, refer to the Oracle Application Server 
Documentation Library. The library is available on the Oracle Technology Network.
Oracle Technology Network link has the following URL:
http://www.oracle.com/technology/documentation/index.html

3 Oracle JDeveloper 10.1.3.1 (Studio Version)
Download Oracle JDeveloper from:
http://www.oracle.com/technology/software/products/jdev/archives.html.
This is a free download. Support for JDeveloper is not included. If desired, support for JDeveloper 
can be purchased separately. For information on installing Oracle JDeveloper, refer to the Oracle 
Technology Network. Oracle Technology Network link has the following URL:
http://www.oracle.com/technology/documentation/index.html

4 Oracle Warehouse Builder 10gR2 10.2.0.1 (optional component)
Oracle Warehouse Builder is an optional component that should be used to perform initial data 
synchronization from Oracle E-Business Suite to Siebel CRM On Demand if customer or product 
data already exists in E-Business Suite. Use of OWB for initial data synchronization requires the 
ETL and Data Quality options from Oracle Warehouse Builder. OWB is not included in this media 
pack and, if needed, must be licensed separately.

Installing Oracle E-Business Suite Patches
Install the Oracle E-Business Suite patches described in this section. If a patch has already been 
installed, there is no need to reinstall it. The latest version of each patch can be downloaded from 
http://metalink.oracle.com.
Siebel CRM On Demand Integration Pack for Oracle E-Business Suite 
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Installing and Configuring the Applications ■ Process of Installing Components
1 Download the Oracle E-Business Suite patches. The file name is:
EBS_Patches_AIAv1.1.tar.gz 

2 Use the tar utility to extract the Oracle E-Business Suite patches from 
EBS_Patches_AIA1.1.tar.gz. The command is:
tar -xzf EBS_Patches_AIA1.1.tar.gz

3 After extracting, there are two tar files: platform.tar and generic.tar.

4 Extract these two tar files using these commands:
tar -xf platform.tar
tar -xf generic.tar

5 Extracting from generic.tar yields a set of platform-independent EBS patch zip files. Apply each 
of these patches to your Oracle E-Business Suite application.

6 Extracting from platform.tar yields six platform-specific tar files:
aix.tar, hpux11.tar, linux.tar, solaris.tar, tru64.tar, and winnt.tar.

7 Use the appropriate platform file for your Oracle E-Business Suite installation to yield the 
platform-specific patch zip files.
Example: tar -xf solaris.tar

8 Apply each of these patches to your Oracle E-Business Suite application.

Table 2 lists the patches that must be installed for Oracle E-Business Suite (EBS).

NOTE: Always check Metalink for the latest versions of all patches.

Table 2. Mandatory Patches for Oracle E-Business Suite

Patch Number Comments

3618299 (HZ.N) This patch is a prerequisite for patch 5046954.

5046954 This patch contains PL/SQL Application Programming Interfaces that are called 
by the integration processes. It also contains the code that raises business 
events that are picked up by the integration processes.

5221628 Oracle E-Business Suite patch contains the new Oracle E-Business Suite user 
interface for create account, create contact, and so on, which are embedded 
in Siebel CRM On Demand as Web links. It also contains Subscription to 
Business Events.

6021150 This patch enables product business events, which are used for product 
synchronization between Oracle E-Business Suite and Siebel CRM On Demand.

5368824 This patch hides hyperlinks on Data Quality Management pages.

5398458 Enhancements for OCO Transaction Viewer.

5451612 A JTT patch that enables Quoting Navigation.

5505578 This patch installs Quoting updates.

5605532 This patch installs the Order Capture updates.
Siebel CRM On Demand Integration Pack for Oracle E-Business Suite
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Installing and Configuring the Applications ■ Process of Installing Components
Table 3 lists recommended patches to be installed.

Installing Fusion Middleware and JDeveloper Patches
Install the Fusion Middleware and JDeveloper patches described in this section. If any particular 
patch has already been installed, there is no need to reinstall it. The latest version of each patch can 
be downloaded from http://metalink.oracle.com.

1 Download the Fusion Middleware and JDeveloper patches. The file name is:
FMW_Patches_AIAv1.0.zip

2 Unzip the file to yield the mandatory bug-fix patches listed in Table 4.

Table 4 lists the patches that must be installed.

5839660 UIX version 2.2.24 and patch for Oracle E-Business Suite 11.5.10CU2.

5916062 This patch is to be applied to the Oracle EBS HTTP Server enables non-ASCII 
character support.

Table 3. Recommended Patches for Oracle E-Business Suite

Patch Number Comments

4280097 This patch is required if you are using Customer Merge capabilities in Oracle 
E-Business Suite.

4351001 This patch hides the Update icon on Duplicate Prevention pages.

4775835 Fixes an error in messageLOVChoice for Country and Currency when used with 
the custom Siebel CRM On Demand Look and Feel in combination with a non-
English language.

Table 4. Patches for Fusion Middleware and JDeveloper

Patch Number Comments

5473225 Fixes problems that involve catching an exception during a transform.

5596476 Fixes problems that involve the XSLT map not rendering in the user interface.

5609537 Fixes issues with commit in child processes.

Table 2. Mandatory Patches for Oracle E-Business Suite

Patch Number Comments
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Installing and Configuring the Applications ■ Configuring Components
3 Apply each of these patches to your installation.

4 Refer to the ReadMe.txt in each patch for guidance on how to apply the patch.

Installing and Deploying Siebel CRM On Demand 
Integration Pack for Oracle E-Business Suite
To extract the integration files, complete the following procedure.

To deploy the integration on SOA Suite

1 Unzip file Fmw_apr07_rup.zip under <SOA Suite Home>/BPEL directory (this directory is created 
during the SOA Suite Installation.) 
Unzipping extracts a copy of this ReadMe file and SEBLODIntegPkEBS.zip that contains the 
integration files.

2 Unzip SEBLODIntegPkEBS.zip. Unzipping extracts the integration files into a new directory 
named:
SEBLODIntegPkEBS.

Configuring Components
This section covers the configuration of components. These tasks must be completed in the specific 
order listed:

1 Locating Integration Files on page 22

2 Configuring and Deploying Common Schema on page 23

3 Configuring the Domain Value Maps on page 24

4 Configuring the Error Logging Database on page 25

5917910 Fixes problems that involve:

■ Creating <XSL:variable> with value "&#0;"

■ Java heap error on Service Oriented Architecture Suite, V10.1.3.1 release 
on Linux.

■ Invoking PL/SQL procedure with a large output parameter.

5931554 Fixes problems that involve:

■ Cross-reference feature

■ XPATH function, LOOKUP-DVM, but does not work in assign activity of 
Business Processes Execution Language.

Table 4. Patches for Fusion Middleware and JDeveloper

Patch Number Comments
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5 Configuring Siebel CRM On Demand Session Pooling on page 26

6 Creating Oracle E-Business Suite Connection Information on page 27

7 Creating OracleCRMODDataSource on page 28

8 Creating Error Database Connection Information on page 29

9 Creating J2EE Data Sources on page 29

10 Creating Adapter Data Sources on page 31

11 Preparing Business Processes Execution Language Processes for Deployment on page 32

12 Deploying the Business Processes Execution Language Processes Using Automatic Process 
Deployment on page 33

13 Configuring the Servers Using JDeveloper for Manual Process Deployment on page 35

14 Deploying the Business Processes Execution Language Processes Manually on page 36

15 Setting Business Processes Execution Language Options on page 38

16 Setting Service Oriented Architecture Suite Proxy Server Properties on page 39

17 Finding Business Processes Execution Language Endpoint URLs for E-Business Suite Profiles on 
page 39

18 Starting the CRMIntegSEBLODPollingSchedulerAsync Process on page 40

19 Purging Process Instances on the Business Processes Execution Language Console on page 40

Locating Integration Files
The integration files are contained in the SEBLODIntegPkEBS directory. This directory was created 
when you unzipped SEBLODIntegPkEBS.zip according to the instructions in the Siebel CRM On Demand 
Integration Pack Quick Installation Guide.

The SEBLODIntegPkEBS directory contains the following directories:

■ BulkDataLoad. Has content for performing an initial data load of customer and product data from 
Oracle E-Business Suite to Siebel CRM On Demand, if necessary.

■ BusinessProcesses. Has content for ongoing synchronization.   These are the Oracle Business 
Processes Execution Language (BPEL) processes and related content.

■ SetUp. Contains setup content for BPEL Processes.

■ SharedComponents. Has shared components for BPEL Processes.

You need these directories and their files to complete the remaining installation and configuration 
tasks.
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Configuring and Deploying Common Schema
To configure the common schema use the following procedure. Table 5 shows the parameters being 
used and their purpose.

To configure CRM On Demand session parameters

1 Create a CRM On Demand Session parameter table:

create table od_sessionparam (Name varchar(1024) NULL, Value varchar(1024) NULL)

2 Seed the CRM On Demand Session Parameter table with the following configuration parameters:

insert into od_sessionparam (Name, Value) Values ('od.password','<odpassword>')
insert into od_sessionparam (Name, Value) Values ('od.username','<odusername>')
insert into od_sessionparam (Name, Value) Values ('max.session.size','3')
insert into od_sessionparam (Name, Value) Values ('session.timeout','5')
insert into od_sessionparam (Name, Value) Values ('session.badDue','10')
insert into od_sessionparam (Name, Value) Values ('ProxyHost','<proxyhost>')
insert into od_sessionparam (Name, Value) Values ('ProxyPort','<proxyport>')
insert into od_sessionparam (Name, Value) Values ('QueryPageSize','100')
insert into od_sessionparam (Name, Value) Values 
('ConfigTable','ORABPEL.OD_CONFIG')
insert into od_sessionparam (Name, Value) Values ('od.webservice.endpoint','<CRMOD 
Server  URL>/Services/Integration')
insert into od_sessionparam (Name, Value) Values ('AccountDetail','<CRMOD Server  
URL>/OnDemand/user/
AccountDetail?OMRET0=%2fOnDemand%2fuser%2fAccountHomePage&OMTHD=AccountDetailNav&O
MTG 
T=AccountDetailForm&AccountDetailForm.Id=[%%AccountId%%]&ocTitleField=Name&ocEdit=

Table 5. CRM On Demand Session Parameters

Parameter Purpose

<jdbc.url> The URL of the database used by BPEL installation.

<olite.user> The user name for the database used by BPEL installation.

<olite.password> The corresponding password for <olite.user>.

<od.username> Your Siebel CRM On Demand administration user name.

<od.password> The corresponding password for <od.username>.

<ProxyHost> The URL for the Proxy host where the proxy server is running.

<session.timeout> The time out value for a session.

<session.badDue>

<od.webservice.endpoint>

<ProxyPort> The port number for Proxy port.

<max.session.size> The number of Siebel CRM On Demand sessions to be pooled in 
SOA Server. A suggested value is 5.
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Y')
insert into od_sessionparam (Name, Value) Values ('ContactDetail','<CRMOD Server  
URL>/OnDemand/user/
ContactDetail?OMTGT=ContactDetailForm&OMTHD=ContactDetailNav&OMRET0=ContactHomePag
e&C ontactDetailForm.Id=[%%ContactId%%]&ocTitleField=Name&ocTitle=Name&ocEdit=Y')
insert into od_sessionparam (Name, Value) Values ('OpportunityDetail','<CRMOD Server  
URL>/OnDemand/user/
OpportunityDetail?OMRET0=%2fOnDemand%2fuser%2fOpportunityHomePage&OMTHD=Opportunit
yDe 
tailNav&OMTGT=OpportunityDetailForm&OpportunityDetailForm.Id=[%%OpportunityId%%]&o
cTitleField=Name&ocEdi t=Y')
insert into od_sessionparam (Name, Value) Values ('LeadDetail','<CRMOD Server  URL>/
OnDemand/user/
LeadsDetailPage?OMTGT=LeadDetailForm&OMTHD=LeadDetailNav&OMRET0=LeadsHomepage&Lead
Det ailForm.Id=[%%LeadId%%]&ocTitleField=Name&ocEdit=Y')

3 Restart the SOA Suite server.

4 To verify, make sure that the following URL shows an XML file:

http(s)://[SOA HOST]:[PORT]/orabpel/xmllib/SEBLODIntegPkEBS/
CRMIntegSEBLODSchema.xsd

Configuring the Domain Value Maps
A sample Domain Value Map (DVM) is provided as an XML file conforming to the Oracle SOA Suite 
DVM schema. Use ESB administration to import the XML file. You can then modify it as needed by 
adding additional rows, but do not change the following:

■ The DVM name

■ Column names

■ The number of columns

The following DVMs are used in the customer integration:

■ STATE or PROVINCE in EBS. In Oracle E-Business Suite there are two properties captured for 
an address (HZ_LOCATION). STATE or PROVINCE. For each country only one property needs to 
be used. For the US, this DVM is not used, instead the STATE property is used. For other countries 
the default is PROVINCE. Each row has a two-digit country code (for example: US) and a 
corresponding property preference (for example: STATE). Its XML filename can be located at:

/SEBLODIntegPkEBS/SharedComponents/Utility/DVM/Maps/STATE or PROVINCE in EBS.xml

■ County Code Mapping between Oracle E-Business Suite and Siebel CRM On Demand. 
Oracle E-Business Suite uses two character country codes, but Siebel CRM On Demand uses the 
entire name of the country. To compensate for this difference, this mapping file is used to look 
up the corresponding Siebel CRM On Demand country code when synchronizing account and 
contact records. Its XML filename can be located at:

/SEBLODIntegPkEBS/SharedComponents/Utility/DVM/Maps/
CRMIntegSEBLODCountryISOCodes.xml
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To configure the domain value map

1 From the Oracle SOA Suite main page (http(s)://[SOA HOST]:[PORT]/) click on the ESB Control 
link.

2 Log in with an administrative user name.

3 Click the DVM icon.

4 Choose Create > Import New Map

5 Select the following file and click OK.

/SEBLODIntegPkEBS/SharedComponents/Utitlity/DVM/Maps/STATE or PROVINCE in EBS.xml

6 This creates a domain value map named STATE or PROVINCE in EBS.

7 Choose Create > Import New Map.

8 Select the following file and click OK.

/SEBLODIntegPkEBS/SharedComponents/Utitlity/DVM/Maps/
CRMIntegSEBLODCountryISOCodes.xml

This creates a domain value map named CRMIntegSEBLODCountryISOCodes.

The above steps establish the default domain value maps. Update these to reflect the actual values 
in your Oracle E-Business Suite and Siebel CRM On Demand instances.

Configuring the Error Logging Database
The Siebel CRM On Demand Integration Pack for Oracle E-Business Suite needs an error logging 
database.

To configure the database

1 Decide on a password for the ERRORADMIN account and substitute it for the <PASSWORD> 
variable in the following step.

2 Create the following user:

CREATE USER ERRORADMIN
IDENTIFIED BY VALUES ‘<PASSWORD>’
DEFAULT TABLESPACE ERRORHANDLING
TEMPORARY TABLESPACE TEMP
PROFILE DEFAULT
ACCOUNT UNLOCK;

3 Grant the following user privileges:

GRANT ALTER ANY TABLE TO ERRORADMIN;
GRANT ALTER ANY TYPE TO ERRORADMIN;
GRANT CREATE SESSION TO ERRORADMIN;
GRANT CREATE SYNONYM TO ERRORADMIN;
GRANT CREATE ANY TABLE TO ERRORADMIN;
GRANT CREATE ANY TYPE TO ERRORADMIN;
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GRANT DROP ANY TABLE TO ERRORADMIN;
GRANT UNLIMITED TABLESPACE TO ERRORADMIN;
GRANT INSERT ANY TABLE TO ERRORADMIN;
GRANT SELECT ANY TABLE TO ERRORADMIN;
GRANT UPDATE ANY TABLE TO ERRORADMIN;

4 Create the ERROR_DATABASE table in the ERRORADMIN schema.

CREATE TABLE ERROR_DATABASE
(

CALLINGPROCESSNAME        VARCHAR2(60 BYTE),
CALLINGPROCESSINSTANCEID  VARCHAR2(10 BYTE),
FAULTTEXT                 VARCHAR2(1000 BYTE),
FAULTSTACK                VARCHAR2(1000 BYTE),
FAULTCONTEXT              VARCHAR2(200 BYTE),
PROCESSINPUTPAYLOAD       CLOB

);

Configuring Siebel CRM On Demand Session Pooling

For the best performance, Siebel CRM On Demand sessions need to be cached in an SOA middle tier. 
Cached sessions need to be pooled across BPEL processes. Perform the following setup on the Oracle 
Database used by BPEL Process manager.

To configure the Siebel CRM On Demand session pooling table

1 Using the <olite.user>, <olite.password>, and <JDBC.URL> specified in 
CRMIntegSEBLODConfig.xml, create the following table and insert the following rows (currently 
there are five rows assuming that <max.session.size> is set to 5 in CRMIntegSEBLODConfig.xml. 
If there are more than five, insert additional rows, with each row having a unique SESSION_NUM 
value.)

CREATE TABLE OD_POOL
(SESSION_NUM int NOT NULL,
SESSION_ID char(255) NULL,
IS_LOCKED char(10) NOT NULL,
LAST_RELEASED timestamp NULL,
LAST_LOCKED timestamp NULL);

INSERT INTO OD_POOL(SESSION_NUM, SESSION_ID, IS_LOCKED, LAST_RELEASED, 
LAST_LOCKED) VALUES(1, null, 'N', null, null);

INSERT INTO OD_POOL(SESSION_NUM, SESSION_ID, IS_LOCKED, LAST_RELEASED, 
LAST_LOCKED) VALUES(2, null, 'N', null, null);

INSERT INTO OD_POOL(SESSION_NUM, SESSION_ID, IS_LOCKED, LAST_RELEASED, 
LAST_LOCKED) VALUES(3, null, 'N', null, null);

INSERT INTO OD_POOL(SESSION_NUM, SESSION_ID, IS_LOCKED, LAST_RELEASED, 
LAST_LOCKED) VALUES(4, null, 'N', null, null);
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INSERT INTO OD_POOL(SESSION_NUM, SESSION_ID, IS_LOCKED, LAST_RELEASED, 
LAST_LOCKED) VALUES(5, null, 'N', null, null);

CREATE TABLE OD_CONFIG
(NAME varchar(255)  NULL,
VALUE varchar(255) NULL);
INSERT INTO OD_CONFIG (NAME, VALUE) VALUES (“PollingStatus”, “Polling”);
INSERT INTO OD_CONFIG (NAME, VALUE) VALUES (“MaximumPollingWindowSize”, “3600”);

Creating Oracle E-Business Suite Connection 
Information
To create Oracle E-Business Suite connections, use the following procedure.

To configure Oracle E-Business Suite connection information

1 From the Oracle SOA Suite main page click the link for Application Server Control. 

2 Log in as an administrative user.

3 Under All Application Servers, click on the SOA application server name.

4 Click on the OC4J J2EE container name.

5 Click Administration tab.

6 Navigate to Administration Tasks > Services > JDBC Resources, and then click Go to Task.

7 Under Connection Pools, click Create.

8 From the Application picklist, choose the appropriate domain (for example: default).

9 Under Connection Pool Type, choose New Connection Pool.

10 Click Continue.

11 Enter this name: OracleEBSDataSource

12 Under URL, click on JDBC URL and enter appropriate host:port:service name. For example:
jdbc:oracle:thin:@<EBS Server URL>:<Port>:<ServiceName>

13 Under Credentials, enter an E-Business Suite username and password that has APPS schema 
privilege (for example, APPS/APPS.)

14 Click Finish.

15 Test the connection by clicking Test Connection for the OracleEBSDataSource you created.

16 Click Test.

If successful, a confirmation message appears.
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Creating OracleCRMODDataSource
To create OracleCRMODDataSource, use the following procedure.

To create OracleCRMODDataSource

1 From the Oracle SOA Suite main page click the link for Application Server Control.

2 Log in as an administrative user.

3 Under All Application Servers, click the SOA application server name.

4 Click the OC4J J2EE container name.

5 Click the Administration tab.

6 Navigate to Administration Tasks > Services > JDBC Resources, and then click Go to Task.

7 Under Connection Pools, click Create.

8 From the Application picklist, choose the appropriate domain (for example: default).

9 Under Connection Pool Type, choose New Connection Pool.

10 Click Continue.

11 Enter this name:

OracleCRMODDataSource

12 Under URL, click on JDBC URL and enter appropriate host:port:service name. For example:

jdbc:oracle:thin:@example.com:<Port>:exampleInstance

13 Under Credentials, enter the appropriate error database JDBC URL username and password.

14 Click Attributes.

15 Specify the following attribute values:

■ Initial size of Connection Cache: 5

■ Minimum number of connections: 5

■ Maximum number of connections: -1

■ Connection Retry Interval (seconds): 1

16 For the remaining e attributes, accept the default values.

17 Click Finish.

18 Test the connection by clicking Test Connection for the OracleCRMODDataSource you created.

19 Click Test.

If successful, a confirmation message appears.
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Creating Error Database Connection Information
To create error database connections, use the following procedure.

To configure error database connection information

1 From the Oracle SOA Suite main page click the link for Application Server Control. 

2 Log in as an administrative user.

3 Under All Application Servers, click on the SOA application server name.

4 Click on the OC4J J2EE container name.

5 Click Administration tab.

6 Navigate to Administration Tasks > Services > JDBC Resources, and then click Go to Task.

7 Under Connection Pools, click Create.

8 From the Application picklist, choose the appropriate domain (for example: default).

9 Under Connection Pool Type, choose New Connection Pool.

10 Click Continue.

11 Enter this name: ErrorDB

12 Under URL, click on JDBC URL and enter appropriate host:port:service name. For example:
jdbc:oracle:thin:@<EBS Server URL>:<Port>:<ServiceName>

13 Under Credentials, enter the appropriate error database JDBC URL username and password.

14 Click Finish.

15 Test the connection by clicking Test Connection for the ErrorDB you created.

16 Click Test.

If successful, a confirmation message appears.

Creating J2EE Data Sources
To create J2EE data sources, use the following procedure.

To create J2EE data sources

1 Create the following data sources:

■ jdbc/OracleEBSDataSource

■ loc/OracleCRMODDataSource

■ loc/OracleEBSDataSource

■ jdbc/ErrorDB

■ loc/ErrorDB
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2 Create jdbc/OracleEBSDataSource

a Under Data Sources, click Create.

b Under Application, choose an appropriate domain name from the pick list.

c Under Data Type Source, select Managed Data Source.

d Click Continue.

e Enter this name: jdbcOracleEBSDataSource.

f Enter this location: jdbc/OracleEBSDataSource.

g Pick Transaction level: Global &Local Transactions.

h Pick Connection Pool: OracleEBSDataSource.

i Click Finish.

3 Create loc/OracleEBSDataSource.

a Follow the steps above, except:

b Enter name: locOracleEBSDataSource.

c Enter location: loc/OracleEBSDataSource.

d Pick Transaction level: Local Transactions Only.

4 Create jdbc/ErrorDB.

a Follow the steps above, except:

b Enter name: jdbcErrorDB.

c Enter location: jdbc/ErrorDB.

d Pick Transaction level: Global &Local Transactions.

e Pick Connection Pool: ErrorDB.

5 Create loc/ErrorDB.

6 Follow the steps above, except:

a Enter name: locErrorDB.

b Enter location: loc/ErrorDB.

c Pick Transaction level: Local Transactions Only.

d Pick Connection Pool: ErrorDB.

7 Create loc/OracleCRMODDataSource

a Under Data Sources, click Create.

b Under Application, choose an appropriate domain name from the pick list.

c Under Data Type Source, select Managed Data Source.

d Click Continue.

e Enter this name: locOracleCRMODDataSource.
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f Enter this location: loc/OracleCRMODDataSource.

g Pick Transaction level: Local Transactions Only.

h Pick Connection Pool: OracleCRMODDataSource.

i Click Finish.

Creating Adapter Data Sources
The Siebel CRM On Demand Integration Pack for Oracle E-Business Suite needs data sources for the 
adapters.

To create adapter data sources

1 From the Oracle SOA Suite main page click link for Application Server Control.

2 Log in as an administrative user.

3 Under All Application Servers, click on your SOA application server name.

4 Click on your OC4J J2EE container name.

5 Click Applications tab.

6 Click domain name.

7 Configure AppsAdapter

a Click AppsAdapter module.

b Click Connection Factories

c Click Create above JNDI Location.

d Leave default for Connection Factory Interface and Click Continue.

e For JNDI location enter: eis/Apps/OracleEBSDataSource.

f Under Connection Pooling select No Connection Pool.

g Under Configuration Properties, enter dataSource as loc/OracleEBSDataSource and 
xADataSource as jdbc/OracleEBSDataSource.

h Click Finish.

8 Configure AQ Adapter

a Click AqAdapter module.

b Click Connection Factories

c Click Create above JNDI Location.

d Leave default for Connection Factory Interface and Click Continue.

e For JNDI location enter: eis/AQ/OracleEBSDataSource.

f Under Connection Pooling select No Connection Pool.
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g Under Configuration Properties, enter dataSource as loc/OracleEBSDataSource and 
xADataSource as jdbc/OracleEBSDataSource.

h Click Finish.

9 Configure DB Adapter

a Click DbAdapter module.

b Click Connection Factories

c Click Create above JNDI Location.

d Leave default for Connection Factory Interface and Click Continue.

e For JNDI location enter: eis/DB/OracleEBSDataSource.

f Under Connection Pooling select No Connection Pool.

g Under Configuration Properties, enter dataSource as loc/OracleEBSDataSource and 
xADataSource as jdbc/OracleEBSDataSource.

h Click Finish.

i Click Create above JNDI Location.

j Leave default for Connection Factory Interface and Click Continue.

k For JNDI location enter eis/DB/ErrorDB.

l Under Connection Pooling, select No Connection Pool.

m Under Configuration Properties, enter dataSource as loc/ErrorDB and xADataSource as jdbc/
ErrorDB.

n Click Finish.

Preparing Business Processes Execution Language 
Processes for Deployment
Before you can deploy the BPEL process, you must complete some preparation steps.

To prepare Business Processes Execution Language processes

1 Locate the following file and open it for editing:

/SEBLODIntegPkEBS\SetUp\CRMIntegProcessParameters.xml

2 Edit the following parameters.

a Change PARAMVALUE for PARAMNAME “http://127.0.0.1:8888/orabpel/default” to:

http(s)://[YOUR HOST NAME]:[YOUR PORT NUMBER]/orabpel/[YOUR BPEL DOMAIN NAME]

b Change PARAMVALUE for PARAMNAME “http://127.0.0.1:8888/orabpel/xmllib” to:

http(s)://[YOUR HOST NAME]:[YOUR PORT NUMBER]/orabpel/xmllib
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3 Go to \SEBLODIntegPkEBS\SetUp\scripts and run the following command to update the BPEL 
processes with the values specified in CRMIntegProcessParameters.xml.

java -jar EditParam.jar -i <Project Root> -f <CRMIntegProcessParameters.xml 
Location> -verbose -t D:/temp

For example:

java -jar EditParam.jar -i d:/SEBLODIntegPkEBS/BusinessProcesses -f d:/
SEBLODIntegPkEBS/Setup/CRMIntegProcessParameters.xml -verbose -t D:/temp

NOTE: To run EditParam.jar, you need Java Development Kit version 1.4 or newer installed.

4 Copy the contents of \SEBLODIntegPkEBS\BusinessProcesses\Utilities\classes from the build to 
//<SOA Server>/bpel/system/classes.

5 Restart the SOA Server:

a Log in to <SOA Server>/em.

b Select the SOA Instance.

c Click Restart.

d Click Yes on the next two confirmation messages.

e Wait until you get a successful restart response message from the SOA Server.

Deploying the Business Processes Execution Language 
Processes Using Automatic Process Deployment
The Siebel CRM On Demand Integration Pack for Oracle E-Business Suite may either be deployed 
manually or with an automated deployment script. For information on deploying manually, read 
Configuring the Servers Using JDeveloper for Manual Process Deployment on page 35.

If you choose automatic deployment, there are two slightly different procedures: one for deploying 
the Siebel CRM On Demand Integration Pack for Oracle E-Business Suite BPEL processes for the first 
time, and one for updating an existing installation of Siebel CRM On Demand Integration Pack for 
Oracle E-Business Suite processes.

To deploy BPEL processes for the first time
NOTE: This procedure is for the automatic deployment of the BPEL processes assuming no previous 
processes have been deployed for the integration on the SOA server.

1 Make sure that the \SEBLODIntegPkEBS folder is on the same machine where the BPEL processes 
are to be deployed. 

If the folder is not already there, move it to a middle-tier machine after running the EditParam.jar 
and executing the previous procedures. The \SEBLODIntegPkEBS folder should be copied under 
<SOA HOME>\bpel\samples directory.

2 From a command prompt, run this command:

a For Windows:
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<SOA_HOME>\bpel\bin\devprompt.bat

b For Linux:

<SOA_HOME>\bpel\bin\devprompt.sh

3 Navigate to SEBLODIntegPkEBS\BusinessProcesses and run this command:

ant

4 Ignore warnings, if any, while the script is running.

5 Restart the SOA Server.

6 Restart the polling process. For more information, read Starting the 
CRMIntegSEBLODPollingSchedulerAsync Process on page 40.

To update BPEL processes in an existing implementation
NOTE: This procedure is for the automatic deployment of the BPEL processes where processes from 
an existing or new implementation have been deployed for the integration on the SOA server.

1 Restart the SOA Server.

2 Make sure that the \SEBLODIntegPkEBS folder is on the same machine where BPEL Processes 
are to be deployed.

If the folder is not already there, move it to a middle-tier machine after running the EditParam.jar 
and executing all the previous procedures. The \SEBLODIntegPkEBS folder should be copied 
under <SOA HOME>\bpel\samples directory.

3 From a command prompt, run this command:

<SOA_HOME>\bpel\bin\devprompt.sh

4 Navigate to SEBLODIntegPkEBS\BusinessProcesses and run this command:

ant

5 Ignore warnings, if any, while the script is running.

6 Clear the WSDL cache on the SOA Server:

a Go to the BPEL Console.

b Click the BPEL Processes tab.

c Click Clear WSDL Cache.

7 Restart the SOA Server.

8 Restart the polling process. For more information, read Starting the 
CRMIntegSEBLODPollingSchedulerAsync Process on page 40.
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Configuring the Servers Using JDeveloper for Manual 
Process Deployment
Before you can manually deploy the BPEL processes, you must first configure the application server 
and the integration server. Do not use this procedure if you have used automatic deployment as 
described in Deploying the Business Processes Execution Language Processes Using Automatic Process 
Deployment on page 33.

To configure the external jar - CRMODSessionParam.jar

1 Close all open instances of JDEVELOPER.

2 Copy the jar file located under this folder:

\SEBLODIntegPkEBS\BusinessProcesses\Utilities\dist

to:

<JDEV Install folder>/Jdev/lib/ext

To configure the application server

1 Open Oracle JDeveloper.

2 Click Connections Navigator.

3 Under Connections, double-click on Application Server.

4 Click Next.

5 Enter a name for ConnectionName to represent the SOA Suite application server.

6 From Connection Type, select Oracle Application Server 10g 10.1.3.

7 Click Next.

8 For UserName, enter the SOA instance username.

9 For Password, enter the SOA instance password.

10 Select Deploy Password.

11 Click Next

12 For Hostname, enter the server on which the SOA instance is runs.

13 For OPMN Port, leave the default.

14 For OC4J Instance Name, enter the OC4J instance name given during the installation.

15 Click Next.

16 Click Test Connection.

If successful, a confirmation message appears.
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To configure the integration server

1 Open Oracle JDeveloper.

2 Click Connections Navigator.

3 Under Connections, double-click on Integration Server.

4 Click Next.

5 Enter a name for ConnectionName to represent the SOA Suite application server.

6 Click Next.

7 Under Application Server, select the server created in the previous step.

8 Change the port name, as needed, to indicate the port at which SOA Suite instance runs.

9 Click Next.

10 Click Test Connection.

If successful, a confirmation message appears.

Deploying the Business Processes Execution Language 
Processes Manually
Use the following procedure to deploy the BPEL processes manually. Do not use this procedure if you 
have used automatic deployment as described in Deploying the Business Processes Execution 
Language Processes Using Automatic Process Deployment on page 33.

To deploy Business Processes Execution Language processes

1 In JDeveloper, use File > Open to open SEBLODIntegPkEBS/BusinessProccesses/ODSProject.jws

This opens a workspace named ODSProject, which contains the BPEL processes.

2 Right-click on ODSProject, and choose Add to ODSProject.jws

3 Browse to SEBLODIntegPkEBS/BusinessProccesses/SEBLOD/
CRMIntegRemoveContactSEBLODSync.

4 Select CRMIntegRemoveContactSEBLODSync.jpr

5 Click Open.

This brings one additional process into the workspace.

6 For each of the following projects compile the Java code by right-clicking each project name and 
choosing Make:

■ CRMIntegSEBLODGetSession

■ CRMIntegSEBLODPollingSchedulerAsync

■ CRMIntegSEBLODReleaseSession

7 Ignore the warnings listed on the build output window.
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8 For each process in Table 6, complete the following steps to compile and deploy.

a Right-click on the process name, and choose Deploy > <IntegrationServerName> > Deploy 
to your specified domain.

b Ignore any warnings listed on the Compiler tab.

c Check Apache Ant tab for deployment status.

NOTE: These processes must be deployed in the order listed in Table 6.

Table 6. Deployment Order of BPEL Processes

Order Process Name

1 CRMIntegSEBLODGetSession

2 CRMIntegSEBLODReleaseSession

3 CRMIntegErrorHandlerService

4 CRMIntgXformEBS11i10OrgToSEBLOD11Account

5 CRMIntgXformSEBLOD11AccountToEBS11i10Org

6 CRMIntegUpdateOrgEBS11i10Sync

7 CRMIntegUpdateOrgSEBLOD11ToEBS11i10Async

8 CRMIntegXformProductODOraToComEBS11i10ToSEBL782

9 CRMIntegProductUpsertInterface

10 CRMIntegProductUpsertEBS11iToSEBLODAsync

11 CRMIntegSEBLODContactInterfaceSync

12 CRMIntegSEBLODContactValidator

13 CRMIntegSEBLODAccountInterfaceSync

14 CRMIntegSEBLODAccountValidator

15 CRMIntegSEBLODPollUpdatedAccountsAsync

16 CRMIntegSEBLODPollUpdatedContactsAsync

17 CRMIntegSEBLODTimeInterfaceSync

18 CRMIntegSEBLODUserInterfaceSync

19 CRMIntegSEBLODPollingSchedulerAsync

20 CRMIntegAccountLookupEBS11i10toSEBLODSync

21 CRMIntegContactLookupEBS11i10ToSEBLODSync

22 CRMIntegContactUpsertEBS11i10ToSEBLODSync

23 CRMIntegAccountUpsertEBS11i10ToSEBLODSync

24 CRMIntegCreateActEBS11i10ToSEBLOD11Async
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Setting Business Processes Execution Language 
Options
BPEL needs these specific settings for this integration.

To set time out values

1 From the Oracle SOA Suite main page click the link for BPEL Control.

2 Log in as an administrative user.

3 Click Manage BPEL Domain

4 Set syncMaxWaitTime to 300.

5 Open the following file for editing:

<SOA_HOME>/j2ee/<domain>/application-deployments/orabpel/ejb_ob_engine/orion-ejb-
jar.xml

25 CRMIntegCreateContSEBLOD11ToEBS11i10Sync

26 CRMIntegSEBLODOpportunityInterfaceAsync

27 CRMIntegSEBLODLeadInterfaceAsync

28 CRMIntegLeadUpsertEBS11iToSEBLODSync

29 CRMIntegOpportunityUpsertEBS11iToSEBLODSync

30 CRMIntegCreateOrgEBS11i10Sync

31 CRMIntegCreateOptySEBLOD11Sync

32 CRMIntegCreateOrgSEBLOD11ToEBS11i10Sync

33 CRMIntegOpptunityProductLineQueryEBS11i10toSEBLODSync

34 CRMIntegSyncProductEBS11i10ToSEBL782Async

35 CRMIntegSubscribeToBulkloadProductEBS11i10ToSEBL782

36 CRMIntegSubscribeToCreateProductEBS11i10ToSEBL782

37 CRMIntegSubscribeToUpdateProductEBS11i10ToSEBL782

38 CRMIntegUpdateActEBS11i10ToSEBLOD11Async

39 CRMIntegSEBLODActivityInterfaceSync

40 CRMIntegRemoveContactSEBLODSync

41 CRMIntegObjectMergeEBS11i10ToSEBLODSync

42 CRMIntegMergePartyEBS11i10ToSEBLOD11Async

Table 6. Deployment Order of BPEL Processes

Order Process Name
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6 Find the transaction-timeout for the CubeEngineBean element and set its value to 120.

7 Save the file.

8 Restart the SOA application server.

Setting Service Oriented Architecture Suite Proxy 
Server Properties
If the SOA server where the BPEL processes are deployed is behind a proxy server, then you must 
specify the proxy server information.

To set the Service Oriented Architecture Suite proxy server properties

1 From the Oracle SOA Suite main page click the link for Application Server Control.

2 Log in as an administrative user.

3 Under All Application Servers, click on your SOA application server name.

4 Click on your OC4J J2EE container name.

5 Click Administration tab.

6 Click Server Properties under Administration Tasks > Properties.

7 Add the following properties, adjusting the property values to suit your installation:

■ -Dhttp.proxySet=true

■ -Dhttp.useProxy=true

■ -Dhttp.proxyHost=www.example.com

■ -Dhttp.proxyPort=80

■ -Dhttp.nonProxyHosts=*example.com

8 Remove any duplicates of the above

Finding Business Processes Execution Language 
Endpoint URLs for E-Business Suite Profiles
When you set up profiles in Oracle E-Business Suite for this integration, you need to provide BPEL 
endpoint URLs. Follow these steps to find that information.

To find Business Processes Execution Language endpoint URLs

1 From the Oracle SOA Suite main page click the link for BPEL Control.

2 Log in as an administrative user.

3 For a process, click the WSDL tab to find endpoint location.
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4 Use these values to set the appropriate profile options in Oracle E-Business Suite.

Starting the CRMIntegSEBLODPollingSchedulerAsync 
Process
To start the polling process, complete the following task.

To start the CRMIntegSEBLODPollingSchedulerAsync process

1 From the Oracle SOA Suite main page click the link for BPEL Control.

2 Log in as an administrative user.

3 Click BPEL Processes tab.

4 Click CRMIntegSEBLODPollingSchedulerAsync process.

5 Click Initiate to start this process.

6 Provide the following values to the process:

■ Unit = S      (for seconds)

■ Frequency = 3600      (for one hour)

■ WindowStart = (leave this blank to force polling to pick up from where it left off)

7 Click Post XML Message.

8 Click the Instances tab to check if the instances are getting polled.

Purging Process Instances on the Business Processes 
Execution Language Console
As a monthly maintenance measure you can purge the process instances.

To purge process instances on the Business Processes Execution Language console

1 From the Oracle SOA Suite main page click the link for BPEL Control.

2 Log in as an administrative user.

3 Click Instances tab. 

4 Click Purge All Instances.

5 Click Delete All Instances.

6 In the warning message, click Delete All Instances.

This step stops the Siebel CRM On Demand Polling process. When purging is complete, restart 
the CRMIntegSEBLODPollingSchedulerAsync process.
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Process of Configuring the Oracle 
E-Business Suite Environment
To configure the Oracle E-Business Suite environment, perform the following configuration tasks:

■ Configuring Oracle Warehouse Builder on page 41

■ Configuring Oracle Warehouse Builder for the Customer Integration on page 42

■ Configuration Changes for Customer Data on page 44

■ Configuring Changes for Product Data on page 46

■ Configuring for Quoting Integration on page 47

Configuring Oracle Warehouse Builder
This is a step in the Process of Configuring the Oracle E-Business Suite Environment on page 41.

Oracle Warehouse Builder is an optional component, used to perform initial data synchronization 
from Oracle E-Business Suite to Siebel CRM On Demand, if customer or product data already exists 
in Oracle E-Business Suite. If no bulk data loads are required, then you do not need to use Oracle 
Warehouse Builder. Use of Oracle Warehouse Builder for initial data synchronization requires the ETL 
and Data Quality options from Oracle Warehouse Builder. Oracle Warehouse Builder is not included 
in this bundle and, if needed, must be licensed separately.

Before configuring Oracle Warehouse Builder, make sure you have Oracle Warehouse Builder 10g 
Release 2 installed. Warehouse Builder 10g Release 2 (10.2) is supported and certified for use with 
the following releases of the Oracle database:

■  Oracle9i Release 2 (9.2.x, patched to the latest version) Enterprise Edition

■  Oracle Database 10g Enterprise Edition R1 (10.1.x)

■  Oracle Database 10g Standard Edition R2 (10.2.x)

■  Oracle Database 10g Enterprise Edition R2 (10.2.x)

To configure Oracle Warehouse Builder

1 Install the Oracle Warehouse Builder repository on the Oracle database.

2 Make sure that the database character set is compatible with the character set of the Oracle 
E-Business Suite database.

Normally, the Oracle E-Business Suite database has the UTF8 character set. In this case, the 
character set of the Oracle Warehouse Builder repository database is UTF8 or AL32UTF8. Table 1 
on page 15 lists the complete mapping between Siebel CRM On Demand supported language and 
the Oracle database character set.

NOTE: Do not use Excel to edit CSV files generated by Oracle Warehouse Builder, because it 
might create difficulties that relate to the character sets.

3 Start Design Center.
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4 Choose Advanced setup.

5 Enter the connection information (system password, host name, port, and so on).

6 Choose Manage Repository Owner.

7 In the resulting dialog box, select the check box, Skip check box, and click OK.

8 Select the option, Create new Oracle Warehouse Builder Repository owner.

9 Enter a username and password.

The Oracle Warehouse Builder Repository Owner user is required to start and stop the Oracle 
Warehouse Builder Control Center. The Oracle Warehouse Builder Control Center must be running 
to be able to use Oracle Warehouse Builder.

10 Select the appropriate tablespaces, and click Next.

11 Click Create New User.

12 Enter the user information (user name, password, and so on)

13 Grant each user “select” access to v_$parameter table. For example, “grant select on 
v_$parameter to owbdpl”.

You can create multiple Oracle Warehouse Builder repository users to access the same repository.

14 Connect to the Oracle Warehouse Builder Repository using the Oracle Warehouse Builder Design 
Center application (installed as part of the Oracle Warehouse Builder installation).

Configuring Oracle Warehouse Builder for the Customer 
Integration
This is a step in the Process of Configuring the Oracle E-Business Suite Environment on page 41.

To configure Oracle Warehouse Builder for the Customer Integration

1 Make sure the Oracle EBS database user to be used for Customer Initial Load has appropriate 
database access granted as listed below.

Table or View Name Access

EGO_ITEM_SYNC_V Read

HZ_CONTACT_POINTS Read

HZ_CUST_ACCOUNTS Read

HZ_GEOGRAPHIES Read

HZ_GEOGRAPHY_IDENTIFIERS Read

HZ_LOCATIONS Read

HZ_ORG_CONTACTS Read
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2 In the design center, navigate to Design > Import > Warehouse Builder Metadata, and import 
the file named, CRMINTG_XFER_ORGS_TO_OD.mdl.

This creates a project named, CRMINTG_XFER_ORGS_TO_OD.

3 In this project, choose Experts, and then CRMINTG_CUST_XFER_XPRT, 
DO_DEPLOY_AFTER_IMPORT.

4 To start the configuration and deployment of Oracle Warehouse Builder Design, right-click and 
then choose Start.

5 Complete the resulting prompts for implementation-specific information such as your Oracle 
E-Business Suite database, Oracle Warehouse Builder Repository database, and so on.

After successful completion, Oracle Warehouse Builder displays a confirmation message that 
contains the steps needed to export the data.

To configure Oracle Warehouse Builder for the Product Integration

1 In Design Center, navigate to Design > Import > Warehouse Builder Metadata, and import the 
file named, CRMINTEG_PRODUCT_LOAD_OD.mdl.

This creates a project named, CRMINTEG_PRODUCT_LOAD_OD.

2 In this project, choose Experts > CRMINTEG_PRODUCT_EXPERT_MODULE > 
CRMINTEG_PRODUCT_EXPERT.

3 To start the configuration and deployment of Oracle Warehouse Builder Design, right click and 
then choose Start.

4 Complete the resulting prompts for implementation-specific information, such as your Oracle 
E-Business Suite database, Oracle Warehouse Builder Repository database, and so on.

5 Close any windows opened as part of this procedure.

After successful completion, Oracle Warehouse Builder displays a confirmation message that contains 
the steps needed to export the data.

HZ_ORGANIZATION_PROFILES Read

HZ_ORIG_SYS_REFERENCES Read/Write

HZ_ORIG_SYSTEM_REF_S Read

HZ_PARTIES Read

HZ_PARTY_SITE_USES Read

HZ_PARTY_SITES Read

HZ_PERSON_PROFILES Read

HZ_RELATIONSHIPS Read

Table or View Name Access
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Configuration Changes for Customer Data
This is a step in the Process of Configuring the Oracle E-Business Suite Environment on page 41.

The following configuration changes in Oracle E-Business Suite affect the customer data integration:

■ Users and Responsibilities on page 44

■ Data Synchronization Profile Options on page 45

■ Running the Concurrent Program on page 46

■ Setting Up Data Quality Management Options on page 46

Users and Responsibilities
Assign an existing Oracle HTML Quoting user the “Siebel CRM On Demand User” responsibility. Only 
this user is able to log in and access the custom UI pages that are invoked from Siebel CRM On 
Demand.

The set up for a quoting user is a prerequisite. For more information, see the appropriate sections 
of the Oracle E-Business Suite Quoting Implementation Guide.

Creating a Synchronization Account
This is a step in the Process of Configuring the Oracle E-Business Suite Environment on page 41.

To perform synchronization of account, address, and contact information from Siebel CRM On 
Demand to Oracle E-Business Suite, a new user account is required on the Oracle E-Business Suite 
installation. Changes to data on Oracle E-Business Suite are performed using this new user account.

To create a synchronization account

1 Navigate to the System Administrator responsibility (Security > User > Define) in Oracle 
E-Business Suite.

2 Enter “User Name” = “ON_DEMAND_INT”

3 Specify a password for the synchronization account.

4 Assign the responsibility, Siebel CRM On Demand User, and save it.
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Data Synchronization Profile Options
Table 7 lists the profile options and their appropriate levels that need to be set to enable data 
synchronization from Oracle E-Business Suite to Siebel CRM On Demand.

Table 7. Profile Options and Levels

Profile Name Purpose Value Level

Siebel CRM On 
Demand Integration 
Account WSDL 
Location

New account custom 
UI calls BPEL process 
at this location.

Endpoint location for 
BPEL process 
CRMIntegCreateOrgSEBL
OD11ToEBS11i10Sync

Site

Siebel CRM On 
Demand Integration 
Contact WSDL 
Location

New contact custom 
UI calls BPEL process 
at this location.

Endpoint location for 
BPEL process 
CRMIntegCreateContSEB
LOD11ToEBS11i10Sync

Site

Siebel CRM On 
Demand Integration 
Lead WSDL Location

Converts Lead custom 
UI calls BPEL process 
at this location.

Endpoint location for 
BPEL process 
CRMIntegCreateOptySEB
LOD11Sync

Site

HZ: Format Business 
Object Business 
Events as Bulk

For Data 
Synchronization from 
Oracle E-Business 
Suite to Siebel CRM 
On Demand.

No Site

HZ: Execute API 
Callouts

For Data 
Synchronization from 
Oracle E-Business 
Suite to Siebel CRM 
On Demand.

All Events Enabled Site

Oracle Applications 
Look and Feel

Sets the style sheet 
for a custom UI similar 
to Siebel CRM On 
Demand.

Siebel CRM On Demand 
Look and Feel

Responsibility: 
Siebel CRM On 
Demand User

User: User created in 
3.1.1.1

Siebel CRM On 
Demand Host Location

Used to build the 
Cancel button URL for 
custom pages.

A URL similar to:
https://secure-
ausomxafa.crmondemand
.com
Notice there is no “/” at 
the end.

Site
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Running the Concurrent Program
To enable data synchronization from Oracle E-Business Suite to Siebel CRM On Demand, run the 
concurrent program named, TCA Business Object Events: Raise Events Program with the appropriate 
responsibility (for example, Trading Community Manager). This program raises Trading Community 
Architecture BES Events for Business Objects. It applies to Create and Updated to customer data in 
Oracle E-Business Suite. Schedule it for intervals that are appropriate to your customer data create 
and update volume.

Setting Up Data Quality Management Options
To prevent duplicate records from occurring, the Siebel CRM On Demand Integration Pack for Oracle 
E-Business Suite includes a Duplicate Prevention workflow. To set up the Data Quality Management 
(DQM) options, use the list in Table 8. The values in this table are suggestions, you can modify them 
for your specific environment. For more information on these profiles and their values, see DQM 
Administration Guide.

Configuring Changes for Product Data
This is a step in the Process of Configuring the Oracle E-Business Suite Environment on page 41.

To configure Oracle E-Business Suite for the product data synchronization, complete the following 
tasks:

■ Assign the responsibility, Inventory, to each user.

Table 8. Data Quality Management Options

Profile Name Purpose Value Level

HZ: Enable DQM 
Party Search

Required to Enable DQM Yes Responsibility: 
Siebel CRM On 
Demand User

HZ: Enable Duplicate 
Prevention at Party 
Creation

To enable duplication 
prevention at the time of 
party creation

Person and 
Organization

Responsibility: 
Siebel CRM On 
Demand User

HZ: Match Rule for 
Organization 
Duplicate Prevention

Match Rule to be used for 
Organization Duplicate 
Prevention

HZ_ORG_SIMPLE_SE
ARCH_RULE 

Responsibility: 
Siebel CRM On 
Demand User

HZ: Match Rule for 
Person Duplicate 
Prevention

Match Rule to be used for 
Person Duplicate 
Prevention

HZ_PERSON_SIMPLE
_SEARCH_RULE

Responsibility: 
Siebel CRM On 
Demand User
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■ Verify that the BPEL processes for Product synchronization are deployed on the BPEL server. 
Table 9 lists these processes.

Configuring for Quoting Integration
To configure Oracle E-Business Suite for the Quoting Integration, complete these tasks:

■ Implementing the Siebel CRM On Demand Look-and-Feel on page 47

■ ASO: Auto Account Creation Profile on page 48

■ ASO: On Demand Integration URL Profile on page 48

■ Preventing Navigation Issues on Quote Related Pages on page 49

Implementing the Siebel CRM On Demand Look-and-Feel
Implementing the Siebel CRM On Demand Look-And-Feel is optional. It does not affect the ability to 
access the quote listing pages, it affects only how these pages render on the screen.

Table 9. BPEL Processes for Product Synchronization

Process Name Purpose

CRMIntegProductUpsertEBS11i
ToSEBLODAsync

Transforms the product from the common object schema to the 
Siebel CRM On Demand Schema

CRMIntegProductUpsertInterfa
ce

Initiates the Siebel CRM On Demand Web service API

CRMIntegSubscribeToBulkloadP
roductEBS11i10ToSEBL782

Subscribes to oracle.apps.ego.item.postItemBulkload event and 
initiates the synchronization process

CRMIntegSubscribeToCreatePro
ductEBS11i10ToSEBL782

Subscribes to oracle.apps.ego.item.postItemCreate event and 
initiates the synchronization process

CRMIntegSubscribeToUpdatePr
oductEBS11i10ToSEBL782

Subscribes to oracle.apps.ego.item.postItemUpdate event and 
initiates the synchronization process

CRMIntegSyncProductEBS11i1
0ToSEBL782Async

Main Item Sync Process; This queries ego_item_sync_v and 
prepares a payload for On Demand (Master Items alone).

This payload is transformed to CO schema. This payload is 
passed over to Siebel services for Siebel CRM On Demand.

CRMIntegXformProductODOraT
oComEBS11i10ToSEBL782

Transforms the payload from the Oracle schema to the common 
object schema
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To enable the Siebel CRM On Demand look-and-feel on the related Oracle E-Business Suite quote 
listing pages, you must include the style classes defined in the following paragraph within a copy of 
the jtfcuss.css style sheet that ships with the Oracle E-Business Suite (for example: oducss.css). 
These style classes must also be included in a copy of the jtfcusss_med.css and jtfcuss_sml.css (for 
example: oducss_med.css and oducss_sml.css). Set the profile JTF_PROFILE_DEFAULT_CSS to the 
newly copied style sheet (for example: oducss.css). For this change to take effect you must restart 
the Oracle E-Business Suite Middle Tier.

Make a copy of the original jtfcuss.css file, rename the copied file and set the 
JTF_PROFILE_DEFAULT_CSS to the newly copied style sheet. This preferable to directly modifying 
the jtfucss.css file directly, as changes are not preserved during patching or upgrades under this 
approach.

The style classes to be included in the copy of jtfcuss.css are:

.SblTableTitlebar { background-color: #6689c2; font-family: tahoma, sans-serif; 
font-size: 8pt; font-weight: bold; padding: 5px 10px 5px 10px; border: 1px solid; 
border-color: #8ca6d1 #41639d #41639d #8ca6d1; color: #fff}

.SblTableAlphaFilterBar{background-color: #b2c2df;font-family: tahoma, sans-serif; 
font-size: 8pt; padding: 1px 5px 1px 5px}

.SblTableHeaderCell { background-color: #ced4dd; font-family: tahoma, sans-serif; 
font-size: 8pt; font-weight: bold; line-height: 12pt; padding: 1px 5px 1px 5px; text-
align: left; white-space: wrap }

.SblTableDataCell { background-color: #f7f7e7; font-family: tahoma, sans-serif; 
font-size: 8pt; padding: 1px 5px 1px 5px; text-align: left }

.SblPageTitle { font-family: tahoma, sans-serif; display: inline; font-size: 11pt; 
font-weight: bold; margin: 0 10px 0 2px}

.SblTableRecordNav { font-family: tahoma, sans-serif; font-size: 8pt}

ASO: Auto Account Creation Profile
Set the ASO: Auto Account Creation profile to “As Required” or “Place Order”. This setting affects the 
Siebel CRM On Demand opportunity conversion for those opportunities that have a customer with 
more than one account associated with it. The resulting behavior is an Oracle E-Business Suite quote 
created for the customer without an account defaulted during the opportunity-to-quote conversion 
process. Users need to manually associate an account with the customer when updating the quote.

ASO: On Demand Integration URL Profile
Set the “ASO: On Demand Integration URL” profile to the On Demand Opportunity Product Line Query 
process on the BPEL Process Manager Server using this format:

http(s)://yourbpelserver.com:7777/orabpel/default/
CRMIntegOpptunityProductLineQueryEBS11i10toSEBLODSync/1.0

For example: http(s)://www.yourcompany.com:7777/orabpel/default/
CRMIntegOpptunityProductLineQueryEBS11i10toSEBLODSync/1.0
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The bold text in the previous URLs is environment specific and is the default location for the process 
on the BPEL Process Manager Server. The location might vary depending on how the process is 
deployed at your site.

Preventing Navigation Issues on Quote Related Pages
To prevent navigating to an unexpected page when accessing the quote related pages (Quote Listing 
for Accounts, Opportunity or the Sales Rep), complete the following task.

To configure navigation

1 Log in as a system administrator.

2 Click Security: Responsibility => Define.

3 Query for the responsibility to be assigned to users for accessing the Oracle HTML Quoting 
module (such as Oracle HTML Quoting Sales Agent), and make a note of the responsibility key 
(such as HTML_QUOTING_SALES_AGENT).

4 Run the following jsp:

http(s)://<server:port>/OA_HTML/qotSSbcJfnToken.jsp?qotRespKey=<Responsibility 
Key>

Example:

http(s)://yourEBSserver.com:7777/OA_HTML/
qotSSbcJfnToken.jsp?qotRespKey=HTML_QUOTING_SALES_AGENT

The jfn token parameter is generated.

5 Copy the jfn token parameter, and append it to the following two Web link URLs, replacing <jfn> 
with the jfn token parameter, which was generated in the previous step:

http(s)://yourEBSserver.com:7777/OA_HTML/
qotSSbpCreate.jsp?qotSblOptyId=%%%Id%%%&qotOptyNm=%%%Name%%%&jfn=<jfn>

http(s)://yourEBSserver.com:7777/OA_HTML/
qotSZzdPopup.jsp?qotFrmDspFile=qotSSbcOptyQuotes.jsp&qotOptyId=%%%Id%%%&qotOpty
Nm=%%%Name%%%&jfn=<jfn>

NOTE: These URLs are required for the following configuration tasks: “Creating Web Tabs” on 
page 50 and “Creating Web Links” on page 51.

6 Complete the task “Creating Web Tabs” on page 50, and then return to this procedure.

NOTE: The following step cannot be successfully completed until the following task (“Creating 
Web Tabs” on page 50) is done.

7 Test the configuration:

a Log in to Siebel CRM On Demand.

b Navigate to the Quotes Tab.
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c Enter the Oracle E-Business Suite username and password for the Sales Rep.

If successful, Siebel CRM On Demand displays the Quote Listing page, listing all quotes 
associated with the Sales Rep.

NOTE: This step can only be done after completing the Web Tab setup described on page 58.

Process of Configuring the Siebel CRM 
On Demand Environment
To configure Siebel CRM On Demand, complete the following tasks:

■ Creating Web Tabs on page 50

■ Creating Web Links on page 51

■ Modifying Layouts on page 53

■ Creating Custom Fields on page 55

■ Modifying Roles on page 55

■ Modifying Pick Lists on page 57

■ Changing Themes on page 58

■ (Optional) Setting Up the Client-Side Browser on page 58

Creating Web Tabs
This is a step in Process of Configuring the Siebel CRM On Demand Environment on page 50.

You need to create three custom Web tabs for these pages: the Account Create page, the Create 
Contact page, and the Quotes page. Follow these guidelines to create those Custom Web Tabs. This 
is a general guideline only, refer to the Siebel CRM On Demand documentation for the exact steps 
and details. Table 10 contains the display names and URLs for Web tab creation.

Table 10. Web Tab Specifics

Display Name URL

Account Create http(s)://<host>:<port>/OA_HTML/
OA.jsp?OAFunc=IMC_SOD_ACCOUNT_CR&OwnerUserId=%%%User 
alias%%%
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To create Web tabs

1 Log in as the Siebel CRM On Demand company administrator.

2 Navigate to Admin > Application Customization > Custom Web Tabs

3 Click New.

4 Specify the name to be displayed on the new Web Tab.

5 In the URL field enter: <<above>>

Creating Web Links
This is a step in Process of Configuring the Siebel CRM On Demand Environment on page 50.

Perform the following steps using the data from Table 11. The URL must be entered exactly as it is 
shown in Table 11. The other fields are recommendations only.

These Web link fields are displayed as hyperlinks even in New Account, Contact, and Lead screens. 
For a successful synchronization of data between Oracle E-Business Suite and Siebel CRM, the user 
must click the Web link hyperlinks after the account, contact, or lead is saved in Siebel CRM On 
Demand.

To create Web links

1 Log in as the Siebel CRM On Demand company administrator.

2 Navigate to Admin > Application Customization > Object > Object Field Setup Page.

3 Click New Custom Field.

4 Specify the Display Name, set the Field Type to Web Link, and click Save.

5 Locate the newly added custom field and click the Edit Web Link.

6 Set the values as described in Table 11, and save the data.

Contact Create http(s)://<host>:<port>/OA_HTML/
OA.jsp?OAFunc=IMC_SOD_CONTACT_CR&OwnerUserId=%%%User 
alias%%%

Quotes http(s)://<host>:<port>/OA_HTML/
qotSZzdPopup.jsp?qotFrmDspFile=qotSSbcRscQuotes.jsp&qotSblNumOfDays
=180&jfn=<jfn token>

For information on generating a jfn token, see To configure navigation on 
page 49.

Table 10. Web Tab Specifics

Display Name URL
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Some URLs listed in Table 11 require a jfn token. For information on generating a jfn token, see 
Preventing Navigation Issues on Quote Related Pages on page 49.

Table 11. Web Link Options

Object
Display 
Name

Display 
Text

Launch 
Behavior

Target 
Custom 
Web Tab URL

Account View 
Quotes

View 
Quotes 
for an 
account

Open in 
Custom 
Web Tab

Quotes http(s)://<host>:<post>/OA_HTML/
qotSZzdPopup.jsp?qotFrmDspFile=qot
SSbcAcctQuotes.jsp&qotHdrPtyId=%
%%External_System_Id%%%&qotHd
rPtyNm=%%%Name%%%& 
jfn=<<jfn token >>

Account 360 View 360 
degree 
view of 
account

Open in 
New 
Window

Not 
applicable

http(s)://<host>:<port>/OA_HTML/
OA.jsp?OAFunc=IMC_SOD_360_VIEW
&ImcPartyId=%%%External_System
_Id%%%&ImcPartyName=%%%Nam
e%%%

Account Create 
New 
Account

Create 
New 
Account

Open in 
Custom 
Web Tab

Account 
Create

http(s)://<host>:<port>/OA_HTML/
OA.jsp?OAFunc=IMC_SOD_ACCOUNT
_CR&OwnerUserId=%%%User 
alias%%%

Activity Account
Merge

Account
Merge

Open in 
New 
Window

Not 
applicable

http(s)://<CRM OnDemand Server 
URL>/OnDemand/user/
AccountMergeWizard?OMTGT=Merge
Wizard&OMTHD=MergeWizard&Merge
Wizard.Step1.SS_Id=%%%Account_I
d%%%

Activity ContactM
erge

Contact
Merge

Open in 
New 
Window

Not 
applicable

http(s)://<CRM OnDemand Server 
URL>/OnDemand/user/
ContactMergeWizard?OMTGT=Merge
Wizard&OMTHD=MergeWizard&Merge
Wizard.Step1.SS_Id=%%%Contact_I
d%%%
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Modifying Layouts
This is a step in Process of Configuring the Siebel CRM On Demand Environment on page 50.

To modify layouts, perform the following task, using Table 12 as a guide.

Lead Convert 
Lead

Convert 
Lead to 
Opportu
nity

Open in 
Custom 
Web Tab

Account 
Create

http(s)://<host>:<port>/OA_HTML/
OA.jsp?OAFunc=IMC_SOD_CONVERT
_LEAD&leadId=%%%Id%%%&Owne
rUserId=%%%User 
alias%%%&leadActName=%%%Com
pany_Name%%%&optyName=%%%
First_Name%%%%20%%%Last_Na
me%%%&optyNext=%%%Next_Step
%%%&optyDesc=%%%Description%
%%&optyRev=%%%Potential_Reven
ue%%%&optyClose=%%%Estimated
_Close_Date%%%&optyId=%%%Op
portunity_Id%%%&leadContFname=
%%%First_Name%%%&leadContLna
me=%%%Last_Name%%%&leadCon
tPhone=%%%Work_Phone_#%%%&
leadContMobile=%%%Cellular_Phone
_#%%%&leadContFax=%%%Fax_Ph
one_#%%%&leadContEmail=%%%E
mail_Address%%%

Opportu
nity

Create 
Quote

Create 
Quote in 
EBS 
System

Open in 
Custom 
Web Tab

Quotes http(s):// <<Oracle EBS Server Host 
Name>>:<<port #>>//OA_HTML/
qotSSbpCreate.jsp?qotSblOptyId=%
%%Id%%%&qotOptyNm=%%%Nam
e%%%&jfn=<<jfn token >>

Opportu
nity

View 
Quotes

View 
Quotes 
for the 
Opportu
nity.

Open in 
Custom 
Web Tab

Quotes http(s)://<host>:<port>/OA_HTML/
qotSZzdPopup.jsp?qotFrmDspFile=qot
SSbcOptyQuotes.jsp&qotOptyId=%%
%Id%%%&qotOptyNm=%%%Name
%%%&jfn=<<jfn token>>

Contact Create 
New 
Contact

Create 
New 
Contact

Open in 
Custom 
Web Tab

Contact 
Create

http(s)://<host>:<port>/OA_HTML/
OA.jsp?OAFunc=IMC_SOD_CONTACT
_CR&OwnerUserId=%%%User 
alias%%%

Table 11. Web Link Options

Object
Display 
Name

Display 
Text

Launch 
Behavior

Target 
Custom 
Web Tab URL
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To modify layouts

1 Log in as the Siebel CRM On Demand company administrator.

2 Navigate to Admin > Application Customization > [Object] > [Object] Layout, where [Object] is 
an object listed in Table 12.

3 Click either Select New Layout or Edit an existing Layout.

4 For new layouts, set the Name.

5 On the Field Setup step, set the appropriate fields to read only, as shown in Table 12.

6 On the Field Layout step, add the listed fields to the Layout.

7 On The Related Information step, add the items in Table 12 to the Displayed Information section.

8 Click Finish.

9 Navigate to Admin > User Management & Access Controls > Role Management.

10 Click Edit for the roles to assign new layout.

11 Navigate to Page Layout Assignment and assign the new layout to the Role.

Table 12. Layout Settings

Object Layout Name Role
Read-Only 
Fields Layout Fields

Related 
Information

Account Account FSR 
Layout

Field Sales 
Rep

Location All Account Web Links 
created in “Creating 
Web Tabs” on page 50.

Addresses

Lead Lead FSR 
Layout

Field Sales 
Rep

N/A All Lead Web Links 
created in “Creating 
Web Tabs” on page 50.

Opportuni
ty

Opportunity 
FSR Layout

Field Sales 
Rep

All Opportunity Web 
Links created in 
“Creating Web Tabs” 
on page 50.

Contact Contact FSR 
Layout

Field Sales 
Rep

Account All Contact Web Links 
created in“Creating 
Web Tabs” on page 50.

Addresses

Opportuni
ty Product

Oppty Product 
FSR Layout

Field Sales 
Rep

Description N/A

Task Task Admin 
Layout

Admin All Activity Web Link 
Fields created in the 
section above.
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Creating Custom Fields
This is a step in Process of Configuring the Siebel CRM On Demand Environment on page 50.

Complete the following procedure to create custom fields needed by this integration.

To create custom fields

1 Log in as the Siebel CRM On Demand company administrator.

2 Navigate to Admin > Application Customization > Account > Account Field Setup Page.

3 Click New Field.

4 Set the Display Name to EBS Status.

5 Confirm that the Integration tag is set to stEBS_Status.

6 Set the Field Type to Text (Short), and click Save.

Modifying Roles
This is a step in Process of Configuring the Siebel CRM On Demand Environment on page 50.

Complete the following procedure to modify roles as needed by this integration.

To modify roles

1 Log in as the On Demand Company System Administrator.

2 Navigate to Admin > User Management & Access Controls > Access profiles.

TIP: Copy the Default and Owner Access profiles and edit the copy.

3 Click either New or Edit.

4 Edit the copied Field Sales Rep Default Access Profile.

a Navigate to Step 2 - Specify Access Levels.

b Set the following values:

❏ Account Access Level to Read/Edit

❏ Account Related Information, Address Account Default Access to Read/Create/Edit.

❏ Contact Default Access to Read/Edit.

❏ Contact Related Information, Address Contact Default Access to Read/Create/Edit.

c Click Finish.

5 Edit the copied Field Sales Rep Owner Access Profile.

a Navigate to Step 2 - Specify Access Levels.

b Set the following values:
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❏ Account Access Level to Read/Edit.

❏ Account Related Information, Address Account Owner Access to Read/Create/Edit.

❏ Contact Owner Access to Read/Edit.

❏ Contact Related Information, Address Contact Owner Access to Read/Create/Edit.

c Click Finish.

6 Navigate to Admin > User Management & Access Controls> Role Management.

7 Either select an existing Role or create a new Role by clicking New Role.

8 On Step 2 – Record Type Access page, complete the following: 

a Make sure the Has Access and Can Read All Records check boxes are checked for Account and 
Contact Record Type Access.

b Make sure the Can Create check box is clear for Account and Contact Record Type Access.

9 On Step 3 – Access Profiles, assign the Access Profile to the role.

10 On Step 4 – Privileges, clear the Convert Leads Privilege check box.

11 On Step 5 - Tab Access & Order, add the Create Contact, Create Account, and Quotes Tabs to the 
Selected Tabs section.

12 On Step 6 – Page Layout Assignment, select the corresponding Page Layout created for the 
Objects in Modifying Layouts on page 53.

13 Click Finish.

Enabling Web Services
This is a step in Process of Configuring the Siebel CRM On Demand Environment on page 50.

Enable Web services in Siebel CRM On Demand by doing the following procedure.

To enable Web services

1 Log in to Siebel CRM as a company administrator.

2 Navigate to Admin > Company Administration > Company Profile > Edit.

3 Check the Web Services Enabled check box.

Merging Records
This is a step in Process of Configuring the Siebel CRM On Demand Environment on page 50.
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After a successful merge operation in Oracle E-Business Suite, an activity is created for the CRM On 
Demand company administrator, as specified in the CRMIntegSEBLODConfig.xml file. Because the 
Oracle E-Business Suite to Siebel CRM On Demand integration user has restricted access to account 
and contact data, only an company administrator can perform a successful merge operation in CRM 
On Demand. If Contacts are merged as part of the Account Merge process in Oracle EBS, on the 
surviving or master account there is no automatic removal of the merged Contacts. If as part of 
merge, new contacts need to be removed from the surviving account, that needs to be done manually 
by the system administrator or data librarian.

Personal Information Manager Synchronization
This is a step in Process of Configuring the Siebel CRM On Demand Environment on page 50.

Because the Oracle E-Business Suite to Siebel CRM On Demand integration user has restricted access 
to account and contact data in Siebel CRM On Demand, this integration user cannot perform a 
successful Personal Information Manager (PIM) synchronization operation in Siebel CRM On Demand.

Modifying Pick Lists
This is a step in Process of Configuring the Siebel CRM On Demand Environment on page 50.

NOTE: Complete modifying the pick lists before loading customer data from Oracle E-Business Suite 
to Siebel CRM On Demand.

To modify pick lists

1 Run the following query using SQLPLUS on the Oracle E-Business Suite instance, and add new 
entries to the “Mr./Ms.” Picklist (Application Layout / Contact Fields) with Siebel CRM On Demand:

2 In Oracle E-Business Suite:

select lookup_code, meaning
from fnd_lookup_values_vl
where lookup_type = 'CONTACT_TITLE'
and view_application_id = 222
and enabled_flag = 'Y'
and sysdate between start_date_active and nvl(end_date_active, sysdate + 1)

3 In Siebel CRM On Demand:

Id = lookup_code
Picklist Values = meaning

4 Also, if a new value is added to CONTACT_TITLE lookup on Oracle E-Business Suite, add the 
corresponding value to the Siebel CRM On Demand picklist.
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Changing Themes
This is a step in Process of Configuring the Siebel CRM On Demand Environment on page 50.

The Siebel CRM On Demand Integration Pack for Oracle E-Business Suite was designed with the 
“Classic” Siebel CRM On Demand theme in mind. By default the “Contemporary” theme is enabled. 
You can change the company theme “Classic” (recommended) by navigating to Admin > Company 
Administration > Company Profile > Company Theme setting.

(Optional) Setting Up the Client-Side Browser
This is a step in Process of Configuring the Siebel CRM On Demand Environment on page 50.

When a user navigates to an Oracle E-Business Suite page embedded within a custom tab, the 
browser might display the following message:

This page contains both secure and nonsecure items
Do you want to display the nonsecure items?

To prevent this, set your browser's security settings to enable the display of mixed content.

To set browser security settings

1 In Internet Explorer navigate to Tools > Internet Options > Security Tab > Local Intranet or 
Internet (depending on whether your Oracle E-Business Suite instance is deployed on the 
internet or on a local intranet).

2 Click Custom Level.

3 In the Miscellaneous section, select Enable for the Display Mixed Content option.

About Using Customized Fields
If you have modified Oracle E-Business Suite using Flex or Extension columns, be aware that these 
columns cannot be directly transferred to Siebel CRM On Demand. Because Siebel CRM On Demand 
is implemented in a hosted environment, no customization of these fields is possible.

It is possible to modify the transformation maps. This is at your own risk, so make sure to make a 
backup copy of the transformation map before attempting any editing. The transformation maps are:

■ For Oracle E-Business Suite to Siebel CRM On Demand, the map file is: 
CRMIntgXformEBS11i10OrgToSEBLOD11Account.xsl.

■ For Siebel CRM On Demand to Oracle E-Business Suite, the map file is: 
CRMIntgXformSEBLOD11AccountToEBS11i10Org.xsl.
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4 Initial Bulk Loading of 
Customer, Contact, and Product 
Data
This chapter describes how to bulk load data from Oracle E-Business Suite into Siebel CRM On 
Demand. Bulk loading is necessary for the initial load, but can be done at any time if needed. This 
chapter contains the following sections:

■ “Bulk Loading of Customer and Contact Data” on page 60

■ “Bulk Loading of Product Data” on page 61

■ “Process of Importing CSV Files into Siebel CRM On Demand” on page 62
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Bulk Loading of Customer and Contact 
Data
Bulk loading of customer and contact data is required when preparing to use the Siebel CRM On 
Demand Integration Pack for Oracle E-Business Suite. Bulk loading can also be used at a later date 
to move large amounts of customer data, for example, after a purchase of customer data or an 
acquisition made by the implementing organization. Bulk loading is a one-way process. Data is 
extracted from Oracle E-Business Suite and imported into Siebel CRM On Demand. Figure 3 illustrates 
the high-level solution for a customer data bulk load.

The Siebel CRM On Demand Data Import infrastructure can import data that is in CSV format. Data 
extracted using Oracle Warehouse Builder must generate four CSV files, each one containing the 
following information:

■ accounts (organization parties)

Figure 3. Initial Bulk Load from Oracle E-Business Suite to Siebel CRM On Demand
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■ account addresses

■ contact addresses

■ Organization contacts

Active organization parties that have at least one active account must export the following data:

■ Organization contacts

■ Active organization party addresses

■ Active contact addresses

Organization parties and organization contacts that are associated with an account in Oracle 
E-Business Suite must be synchronized with Siebel CRM On Demand.

To bulk load customer data by generating CSV files

1 Make sure you have completed “To configure Oracle Warehouse Builder for the Customer 
Integration” on page 42.

2 Navigate to Tools > Control Center Manager.

3 Navigate to CRMINTG_XFER_ORGS_TO_OD > CRMINTG_OWB_REPOS_LOC >   
CRMINTG_OWB_REPOS_MODULE > Mappings.

4 Right-click the CRMINTG_1_ACCT_N_ADDR_TO_FILES map, and choose Start.

The Accounts.csv and Account_addr.csv files are generated in the directory that was specified 
during the execution of the CRMINTG_CUST_XFER_XPRT->DO_DEPLOY_AFTER_IMPORT expert.

5 Wait for the process to complete successfully.

6 Right-click the CRMINTG_2_ACCT_CR_XREF_IN_EBS map, and choose Start.

This process populates the cross-reference information in the Oracle E-Business Suite database.

7 Wait for the process to complete successfully.

8 Right-click the CRMINTG_1_CONT_N_ADDR_TO_FILES map, and choose Start.

The Contacts.csv and Contact_addr.csv files are generated in the directory that was specified 
during the execution of the CRMINTG_CUST_XFER_XPRT->DO_DEPLOY_AFTER_IMPORT expert.

9 Wait for the process to complete successfully.

Bulk Loading of Product Data
Bulk loading of product data is similar to that of bulk loading customer data. However, the product 
data load generates only one CSV file.

To bulk load product data by generating CSV files

1 Make sure you have completed “To configure Oracle Warehouse Builder for the Product Integration” 
on page 43.
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2 Navigate to Tools > Control Center Manager.

3 Navigate to:

CRMINTEG_PRODUCT_LOAD_OD > CRMINTEG_PRODUCT_OWB_LOCATION > 
CRMINTEG_PRODUCT_OWBREP_MODULE > Mappings > CRMINTEG_PRODUCT_EBS_TO_SEBL

4 Right-click the CRMINTEG_PRODUCT_OWBREP_MODULE map, and choose Start.

The CRMINTEG_PRODUCT_EBS_TO_SEBL_OD.cs file is generated in the directory that was 
specified during the execution of the CRMINTEG_PRODUCT_EXPERT_MODULE -
>CRMINTEG_PRODUCT_EXPERT.

5 Wait for the process to complete successfully.

Process of Importing CSV Files into 
Siebel CRM On Demand
The CSV files generated by Oracle Warehouse Builder must be loaded into Siebel CRM On Demand. 
Table 13 lists important information about the loading process. Some CSV files are loaded using the 
Siebel CRM On Demand import wizard, and some are loaded using the OnDemandAddressImport.exe 
executable.
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Make sure the client machine running the Oracle Warehouse Builder client is set to the same 
language that is used for Siebel CRM On Demand.

TIP: A spreadsheet application (such as MS Excel, OpenOffice, and so on) that is used to open the 
CSV file generated from Oracle Warehouse Builder must have support for the character-set enabled 
on the Oracle Warehouse Builder repository. This requirement is primarily applicable to Multiple 
Language Sets installs. Table 1 on page 15 lists the supported character sets.

To complete this process, perform the following tasks:

1 Launching the Siebel CRM On Demand import Wizard on page 63

2 Using the Import Wizard on page 64

3 Configuring the CRMIntegSEBLODAddressLoader.exe.config File on page 64

4 Using the Address Import Executable on page 65

Launching the Siebel CRM On Demand import Wizard
This is a step in Process of Importing CSV Files into Siebel CRM On Demand on page 62.

Table 13. Information about CSV File Loading Process

Suggested 
Load Order CSV File Name Load Using Load Prerequisites

1 Accounts.csv Siebel CRM On 
Demand Import 
Wizard

Load at any time. Suggestion: load this 
file first.

2 Contacts.csv Siebel CRM On 
Demand Import 
Wizard

Load only after the accounts.csv file is 
successfully loaded.

3 Product.csv Siebel CRM On 
Demand Import 
Wizard

Can be loaded at any time.

4 Account_addr.csv Use 
OnDemandAddr
essImport.exe 
executable.

Load only after the accounts.csv file is 
successfully loaded.

5 Contact_addr.csv Use 
OnDemandAddr
essImport.exe 
executable.

Load only after the contacts.csv file is 
successfully loaded.
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To launch the Siebel CRM On Demand import wizard

1 Log in with an account that has the privilege, Administration Import.

2 Navigate to the Admin Homepage.

3 Click Import and Export Tools.

4 Select the object type to Import.

This launches the Import Wizard.

Using the Import Wizard
This is a step in Process of Importing CSV Files into Siebel CRM On Demand on page 62.

To use the import wizard

1 Accept the default options, and select a CSV file using the browse button.

2 Select the provided map file that maps the data in the CSV file to the default Siebel CRM On 
Demand Columns:

■ OnDemand_Account_Field_Mapping.map

■ OnDemand_Contact_Field_Mapping.map

■ OnDemand_Product_Field_Mapping.map

3 You can change the default mapping if desired.

The wizard alerts you about any fields in your data file that were not mapped.

Configuring the 
CRMIntegSEBLODAddressLoader.exe.config File
This is a step in Process of Importing CSV Files into Siebel CRM On Demand on page 62.

The CRMIntegSEBLODAddressLoader.exe.config file must be modified to map to the Siebel CRM On 
Demand server hosting your Siebel CRM On Demand CRM Application and the internet protocol used.

To configure the CRMIntegSEBLODAddressLoader.exe.config file

1 Open the CRMIntegSEBLODAddressLoader.exe.config file with a text editor.

2 Add a key for your Siebel CRM On Demand Server using the following format:

<add key="OnDemandServer" value="[server name]" />

Example:

<add key="OnDemandServer" value="secure-ausomxafa.crmondemand.com" />
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3 If you use an internet protocol other than https://, add a key for the internet protocol you use, 
in the following format:

<add key="InternetProtocol" value="[protocol name]" />

Example:

<add key="InternetProtocol" value="Secure or Non Secure HTTP protocol" />

Using the Address Import Executable
This is a step in Process of Importing CSV Files into Siebel CRM On Demand on page 62.

To use the address import executable

1 Make sure you have .NET Framework 1.1 or newer.

2 Launch the CRMIntegSEBLODAddressLoader.exe executable.

3 Indicate if this is an account address or contact address import.

4 Browse for the file containing the address data.

5 Click Import.
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5 About Integrating Customer 
Data, Products, and Quotes
This chapter describes the integration points for contained in Siebel CRM On Demand Integration 
Pack for Oracle E-Business Suite. It contains the following sections:

■ Integration Assumptions on page 67

■ Customer Data Integration on page 68

■ Product Integration on page 84

■ Quote Integration on page 86

Integration Assumptions
The following conditions are assumed to be present for this integration:

■ Oracle E-Business Suite User Management Assumptions on page 67

■ Customer Data Synchronization Assumptions on page 67

■ Product Data Synchronization Assumptions on page 68

Oracle E-Business Suite User Management Assumptions
When a user logs in to Oracle E-Business Suite seamless navigation between the two applications is 
enabled. The user is prompted to log in to Oracle E-Business Suite when first attempting to access 
an Oracle E-Business Suite page. Subsequent visits to an Oracle E-Business Suite page do not require 
the user to log in. An automatic log-in between Siebel CRM On Demand and Oracle E-Business Suite 
by way of Single Sign-on is not provided in this integration.

The application user must have a user account on both Siebel CRM On Demand and Oracle E-Business 
Suite. The user profiles on each of the respective applications operate independently, with the 
expectation that language preferences and other user preferences and localizations are set up to be 
synchronized between the accounts. It is the user’s responsibility to manually maintain this 
synchronization. This synchronization is not provided in this integration.

Customer Data Synchronization Assumptions
The Siebel CRM On Demand Customer Master and the Oracle E-Business Suite Customer master are 
expected to be synchronized to enable the integration of Siebel CRM On Demand opportunity with 
quoting. Updates to Account and Contact records made by the Admin user specified in the 
CRMIntegSEBLODConfig.xml file are not pushed to the Oracle E-Business Suite. This is to avoid 
endless feedback looping updates to the Account and Contact records in the respective databases.
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The integration assumes that Siebel CRM On Demand users have access to the Oracle E-Business 
Suite application either directly through the company intranet, VPN, or similar.

Product Data Synchronization Assumptions
The Siebel CRM On Demand Product Catalog and Oracle E-Business Suite Item Master are expected 
to be synchronized to enable the Siebel CRM On Demand opportunity product lines to be passed to 
Oracle E-Business Suite quoting. Product data are initially loaded into Siebel CRM On Demand using 
a bulk load. Subsequent changes or product additions in Oracle E-Business Suite are synchronized 
with Siebel CRM On Demand. All product information is maintained within Oracle E-Business Suite 
and synchronized with Siebel CRM On Demand.

Customer Data Integration
After the initial load of the Customer Data from Oracle E-Business Suite into Siebel CRM On Demand 
is complete, the customer records that exist in both applications are synchronized, so that data 
integrity is maintained. Customer data is synchronized whenever an existing customer record that 
exists in both applications is changed in either application or when a new customer record is created 
in Oracle E-Business Suite.

Synchronization Flows
The Customer Data integration consists of the following synchronizations:

■ About Creating New Customers in Oracle E-Business Suite on page 68

■ About Creating New Customers in Siebel CRM On Demand on page 69

■ About Updating Existing Customers in Oracle E-Business Suite on page 74

■ About Updating Existing Customers in Siebel CRM On Demand on page 75

■ About Converting Leads on page 76

■ About Integrating 360° View User Interface on page 77

You cannot create new customers directly in Siebel CRM On Demand, only update existing ones. 
Oracle E-Business Suite is the master for accounts and contacts, and as such new accounts and 
contacts must be created in Oracle E-Business Suite.

About Creating New Customers in Oracle E-Business Suite
When a new Customer Account record is created in Oracle E-Business Suite through any Oracle 
E-Business Suite product UI or Oracle E-Business Suite Public API, a new account is created in Siebel 
CRM On Demand. Any updates made to this customer account later in Oracle E-Business Suite or 
Siebel CRM On Demand are synchronized. New customer accounts created through bulk import 
processes in Oracle E-Business Suite are not synchronized with Siebel CRM On Demand.
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Figure 4 illustrates the data synchronization flow used when a new customer record is created in 
Oracle E-Business Suite.

About Creating New Customers in Siebel CRM On Demand
New customer data in Siebel CRM On Demand is created through a Create Account or Create Contact 
Oracle E-Business Suite application page deployed within the Oracle E-Business Suite middle tier (on 
premise) and made available in Siebel CRM On Demand using a Web link custom tab. You must 
disable the existing links to the standard Create Account or Create Contact functionality in the Siebel 
CRM On Demand User Interface.

New customer data in Siebel CRM On Demand is created using an Oracle E-Business Suite Create 
Account page or Create Contact page embedded within a Siebel CRM On Demand custom tab. The 
existing Create Account or Create contact functionality within the Siebel CRM On Demand user 
interface is disabled as part of the configuration steps. For more information on disabling these 
privileges, see Modifying Roles on page 55.

Figure 4. Create New Customer Accounts in Oracle E-Business Suite - Synchronization Flow
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When an Siebel CRM On Demand user creates a new account or contact, the user is redirected to the 
Create Account or Create Contact application User Interface (UI) page. Figure 5 shows an example 
of the Create New Account page. This application UI page has the look and feel of the standard Siebel 
CRM On Demand User Interface.

Figure 5. The Create New Account Page
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Figure 6 shows an example of the Create New Contact page. This page differs from the standard 
Siebel CRM On Demand Create New Contact page in that the Account section has been removed. This 
section is not required, because in Siebel CRM On Demand, it is a read-only section and displays the 
primary billing address of the Account by default.

Figure 6. The Create New Contact Page
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When the new record is saved it invokes a process flow that creates the new record in both Oracle 
E-Business Suite and Siebel CRM On Demand as illustrated in Figure 7.

Figure 7. Create New Customers in Siebel CRM On Demand—Synchronization Flow
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Figure 8 provides more details on this synchronization flow.

Figure 8. Create New Customer in Siebel CRM On Demand - Detailed Synchronization Flow
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About Updating Existing Customers in Oracle E-Business Suite
Figure 9 illustrates the data synchronization flow when an existing customer record is updated in 
Oracle E-Business Suite. This flow is very similar to creating a new customer record. When a 
relevant, existing customer record is updated in Oracle E-Business Suite, the updated customer 
record is synchronized with Siebel CRM On Demand.

Only newly created or updated Oracle organization parties and organization contacts that are 
associated with an account in Oracle E-Business Suite need to be synchronized with Siebel CRM On 
Demand. Persons Parties (no matter if they are associated with an account in Oracle or not) that do 
not have a relationship with an organization do not need to be synchronized.

Figure 9. Update an Existing Customer in Oracle E-Business Suite - Synchronization Flow
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About Updating Existing Customers in Siebel CRM On Demand
Siebel CRM On Demand can detect changed customer records, but it does not have the capability of 
publishing these changes in real-time. Siebel CRM On Demand is not capable of initiating the 
synchronization flow. A BPEL process polls the Siebel CRM On Demand audit tables to discover these 
updates. This process calls another BPEL process to synchronize the updates for account and 
contacts. Figure 10 illustrates this flow.

Only updated Siebel CRM On Demand accounts and account contacts need to be synchronized with 
Oracle E-Business Suite. Updates to stand-alone contacts (without a relationship with an account) 
are not synchronized. Only updates to Siebel CRM On Demand accounts and account contacts that 
exist in Oracle E-Business Suite need to be synchronized.

Figure 10. Update an Existing Customer in Siebel CRM On Demand - Synchronization Flow
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About Converting Leads
For the Siebel CRM On Demand Integration Pack for Oracle E-Business Suite to work, an opportunity 
in Siebel CRM On Demand must be associated with an existing account. This is not a requirement in 
standard Siebel CRM On Demand. As part of the Siebel CRM On Demand Integration Pack for Oracle 
E-Business Suite, a Convert Lead to Opportunity page is deployed within the Oracle E-Business Suite 
middle tier (on premise) and made available in Siebel CRM On Demand using a Web link. When an 
Siebel CRM On Demand user clicks the Convert Lead link in Siebel CRM On Demand, the user is 
directed to a specialized page that converts the lead into an opportunity. To make the transition 
seamless this page has the look and feel of the standard Siebel CRM On Demand User Interface. 
Figure 11 shows an example of this page.

The relevant fields from the Lead Detail page are displayed by default on the Convert Lead page. You 
can associate an account with this lead either by choosing an existing account from the Account LOV, 
or by entering a new account name. You can optionally create an opportunity from this lead.

Figure 11. The Convert Lead Page
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Figure 12 illustrates the process and data flow that are executed when the process, Create Lead to 
Opportunity, is started from the custom Convert Lead page.

About Integrating 360° View User Interface
A user interface (UI) page is in the Oracle Customer Online application of Oracle E-Business Suite. 
This UI page displays all transactions for a customer, such as invoices, orders, quotes, service 
requests, and so on. It is known as the 360° View, because it provides a full view of all of the 
customer's transactions. This 360° Transaction View page of the Oracle Customer Online application 
is exposed in the Siebel CRM On Demand user interface as a global link, or in a global link custom 
tab, so that an Siebel CRM On Demand user can also get a full view of all of the customer's 
transactions. It opens in a separate browser window.

Figure 12. Process Flow for Converting an Siebel CRM On Demand Opportunity to an Oracle 
E-Business Suite Quote
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Figure 13 illustrates the 360° View.

Customer Data Mappings
The following topics describe how customer data is mapped between Oracle E-Business Suite and 
Siebel CRM On Demand:

■ “Account Entity Attribute Mappings” on page 79

■ Address Entity Attribute Mappings on page 80

■ Contact Entity Attribute Mappings on page 82

Figure 13. The 360° View
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Account Entity Attribute Mappings
Table 14 lists the data mappings for account data.

Table 14. Data Mappings for Account Data

ID

Siebel CRM On 
Demand Attribute 
Name Data Type

Max 
Length

Oracle E-Business Suite Attribute 
Name

1 Account Name.
Indicates the name of 
the account

Text 100 Entity: Organization
Attribute: organization_name
Note: substr (100)

2 Account Currency Picklist
Pre-defined

15 Entity: Organization
Attribute: pref_functional_currency

3 Location.
Indicates the type of 
facility operated by the 
account at this site, 
such as Headquarters

Text 50 Entity: Organization
Attribute: party_number
Note: Siebel CRM On Demand does not 
synchronize this field back to CDH.

4 Web Site
URL address for the 
account

Text 100 Entity: Contact Point
Attribute: URL
Note: Primary for contact_point_type 
= WEB. substr (100)

5 Public Company
Indication that the 
account is a publicly 
owned company

Check box Entity: Organization
Attribute: 
public_private_ownership_flag

6 Annual Revenues
Amount of the 
company's annual 
revenue

Number 15 Entity: Organization
Attribute: curr_fy_potential_revenue

7 Description 
Additional information 
about the account

Text 1999 Entity: Organization
Attribute: mission_statement

8 External Unique ID Text 30 Entity: Organization
Attribute: party_id
Note: Trading Community 
Architecture's party_id for the 
organization

9 Furigana Name
The Furigana 
equivalent of the Kanji 
(for Japanese only)

Text 100 Entity: Organization
Attribute: 
organization_name_phonetic
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Address Entity Attribute Mappings
Table 15 lists the data mappings for address data.

10 Main Fax # Text 40 Entity: Contact Point
Attribute: raw_phone_number
Note: Maps to the primary (or last 
created if no primary) contact point 
where 
CONTACT_POINT_TYPE='PHONE' and 
PHONE_LINE_TYPE='FAX'.

11 Main Phone # Text 40 Entity: Contact Point
Attribute: raw_phone_number
Note: Maps to the primary (or last 
created if no primary) contact point 
where 
CONTACT_POINT_TYPE='PHONE' and 
PHONE_LINE_TYPE!='FAX'.

12 Number of Employees Number Entity: Organization
Attribute: employees_total

Table 15. Address Entity Attribute Mapping

ID

Siebel CRM On 
Demand Attribute 
Name Data Type

Max 
Length

Oracle E-Business Suite Attribute 
Name

1 External Unique ID Text 30 Entity: Party Site
Attribute: party_site_id
Note: Trading Community Architecture's 
party_site_id for the address will be 
stored in this column.

2 Address 1 Text 200 Entity: location
Attribute: address1
Note: substr (200)

3 Address 2 Text 100 Entity: location
Attribute: address2
Note: substr (100)

4 Address 3 Text 100 Entity: location
Attribute: address3
Note: substr (100)

Table 14. Data Mappings for Account Data

ID

Siebel CRM On 
Demand Attribute 
Name Data Type

Max 
Length

Oracle E-Business Suite Attribute 
Name
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5 City Text 50 Entity: location
Attribute: city
Note: substr (50)

6 Country Picklist 30 Entity: location
Attribute: country

8 Province Text 50 Entity: location
Attribute: province
Note: substr (50).

9 US State Picklist 2 Entity: location
Attribute: state
Note: If the country value is US, then 
populate the two-letter state code. For 
other countries, do not populate this 
column, instead populate the province.

10 Billing Zip / Postal Code Text 30 Entity: location
Attribute: postal_code
Note: substr (30)

11 Billing Checkbox N/A Entity: Party Site Use
Attribute: primary_per_type ()
Note: If the site has a primary bill to 
use, set this to Y, otherwise N. Only for 
Account Address.

12 Shipping Checkbox N/A Entity: Party Site Use
Attribute: primary_per_type ()
Note: If the site has a primary ship to 
use, mark this Y, otherwise N. Only for 
Account Address.

13 Primary Checkbox N/A Entity: Party Site 
Attribute: identifying_flag
Note: If the site has identifying_flag = Y, 
mark Y, otherwise N. Only for contact 
address.

Table 15. Address Entity Attribute Mapping

ID

Siebel CRM On 
Demand Attribute 
Name Data Type

Max 
Length

Oracle E-Business Suite Attribute 
Name
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Contact Entity Attribute Mappings
Table 16 lists the data mappings for contact data.

14 Contact External ID Text 30 Entity: Party
Attribute: party_id
Note: Trading Community Architecture's 
party_id for the relationship party is 
stored in this column.

15 Account External ID Text 30 Entity: Party Site
Attribute: party_id
Note: Trading Community Architecture's 
party_id for the organization is stored in 
this column.

Table 16. Contact Entity Attribute Mapping

ID

Siebel CRM On 
Demand Attribute 
Name Data Type

Max 
Length

Oracle E-Business Suite Attribute 
Name

1 External Unique ID Text 30 Entity: Organization Contact
Attribute: relationship_id
Note: Trading Community 
Architecture's party_relationship_id is 
stored in this column.

2 First Name Text 50 Entity: Person
Attribute: person_first_name
Note: substr (50)

3 Last Name Text 50 Entity: Person
Attribute: person_last_name
Note: substr (50)

4 Middle Name Text 50 Entity: Person
Attribute: person_middle_name
Note: substr (50)

5 Mr./Mrs. Picklist 15 Entity: Person
Attribute: person_pre_name_adjunct

6 Furigana First Name Text 50 Entity: Person
Attribute: person_first_name_phonetic
Note: substr (50)

Table 15. Address Entity Attribute Mapping

ID

Siebel CRM On 
Demand Attribute 
Name Data Type

Max 
Length

Oracle E-Business Suite Attribute 
Name
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7 Furigana Last Name Text 50 Entity: Person
Attribute: person_last_name_phonetic
Note: substr (50)

9 Work Phone # Text 40 Entity: Contact Point
Attribute: raw_phone_number
Note: Maps to the primary (or last 
created if no primary) contact point 
where 
CONTACT_POINT_TYPE='PHONE' and 
PHONE_LINE_TYPE='GEN'.

10 Work Fax # Text 40 Entity: Contact Point
Attribute: raw_phone_number
Note: Maps to the primary (or last 
created if no primary) contact point 
where 
CONTACT_POINT_TYPE='PHONE' and 
PHONE_LINE_TYPE='FAX'.

11 Cellular Phone # Text 40 Entity: Contact Point
Attribute: raw_phone_number
Note: Maps to the primary (or last 
created if no primary) contact point 
where 
CONTACT_POINT_TYPE='PHONE' and 
PHONE_LINE_TYPE='MOBILE'.

12 Email Text 100 Entity: Contact Point
Attribute: email_address
Note: Primary one for 
contact_point_type = EMAIL 

13 Department
Name of the 
department of the 
contact

Text 75 Entity: Contact
Attribute: department
Note: See “Contact Notes” on page 84.

14 Job Title Text 75 Entity: Contact
Attribute: job_title
Note: See “Contact Notes” on page 84.

Table 16. Contact Entity Attribute Mapping

ID

Siebel CRM On 
Demand Attribute 
Name Data Type

Max 
Length

Oracle E-Business Suite Attribute 
Name
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Contact Notes
In Siebel CRM On Demand, organization contacts can represent multiple organizations, but these 
attributes are always the same for a person. However, Trading Community Architecture can maintain 
different attributes for each specific organization that a person is related to. Although this 
configuration is more flexible, the reality is that most of the time, one person represents only one 
organization. When Oracle E-Business Suite sends contact information to Siebel CRM On Demand, it 
sends only the information from the oldest organization contact record.

Product Integration
Product information is defined and maintained in Oracle E-Business Suite (in Oracle Item Master) 
and after the initial loading is synchronized with Siebel CRM On Demand in real time. The following 
topics cover product integration:

■ Product Integration Notes on page 84

■ User Procedures on page 85

■ Product Mappings on page 85

Product Integration Notes
The following rules describe the limits and abilities of this integration:

■ Only simple products (flat structure, nonhierarchal product structures) are synchronized.

■ There is no synchronization of Operating Unit information, because Siebel CRM On Demand does 
not support it. Distinct (orderable) products, regardless of Operating Unit are synchronized.

■ Catalog categories and category assignments are not synchronized.

■ Only products eligible for the sales representative to quote are transferred to the Oracle 
E-Business Suite quote upon opportunity-to-quote conversion.

■ The flags, customer ordered and customer orders enabled, must be controlled at the Master 
Organization level and not at the Organization level. Only items flagged as follows, customer 
ordered and customer orders enabled, are included as part of the initial load process into Siebel 
CRM On Demand.

■ In the incremental load even if the flag, customer orders enabled, is not checked then the items 
still synchronize with Siebel CRM On Demand.

■ Products in the Siebel CRM On Demand opportunity must exist on the Oracle E-Business Suite 
default price list during quote creation to be included in a quote. If one of the opportunity product 
lines does not exist in the default price list, it is not included in the quote.

■ Products on the Siebel CRM On Demand opportunity must be associated with the logged-in user's 
item validation organization or operating unit (Org_ID) to be included in the quote during 
conversion. Items that do not belong to the user's associated Item Validation Org are not added 
to the quote.
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■ The quantity associated with the Product Line on an Siebel CRM On Demand opportunity is 
passed to the corresponding line on the Oracle E-Business Suite quote upon conversion. The Unit 
of Measure (UOM) for the product line is derived from the item's Primary UOM on the Oracle 
E-Business Suite product master.

■ If a product is obsolete, indicate this information in Oracle E-Business Suite by setting the 
Customer Ordered Enabled flag to No. Do not set the Customer Order flag to No.

User Procedures
The following procedures are for end users.

TIP: The Item Description field in Oracle E-Business Suite equates to Product Name in Siebel CRM 
On Demand and Long Description in Oracle E-Business Suite equates to Description in Siebel CRM 
On Demand. You might want to clean up the Oracle item descriptions and long descriptions before 
synchronizing.

To create items or products to be synchronized

1 In Oracle Item Master, create a new item.

2 Populate the attributes for the item.

3 Update the item status to Orderable.

The item status change updates the 'Customers Ordered' and 'Customer Orders Enabled' flags 
and Oracle Item Master synchronizes the item with Siebel CRM On Demand Product Master.

To modify items or products

1 Query for the item or product in Oracle Item Master.

2 Update the item attributes.

3 Save the changes to the item.

Oracle Item Master synchronizes the item with Siebel CRM On Demand Product Master.

Product Mappings
Table 17 lists the mappings for products.

Table 17. Product Mappings

Attribute Names in Siebel 
CRM On Demand Attribute Names in Oracle E-Business Suite

Description ITEM_LONG_DESCRIPTION

ExternalSystemId INVENTORY_ITEM_ID||':'||ORGANIZATION_ID
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Quote Integration
The following topics cover the details of the quote integration:

■ Integration Features on page 86

■ Integration Overview on page 87

Integration Features
The Siebel CRM On Demand Integration Pack for Oracle E-Business Suite provides the following 
features:

■ Creating an Oracle E-Business Suite Quote from a Siebel CRM On Demand Opportunity on page 86

■ Displaying Oracle E-Business Suite Quotes Associated with a Siebel CRM On Demand Opportunity on 
page 87

■ Displaying Oracle E-Business Suite Quotes Associated with a Siebel CRM On Demand Customer 
Account on page 87

Creating an Oracle E-Business Suite Quote from a Siebel CRM On 
Demand Opportunity
From within the Siebel CRM On Demand Opportunity Detail page, you can initiate the Create Quote 
process by clicking a custom Web link, which creates an Oracle E-Business Suite quote as a 
background process. The newly created quote takes the Siebel CRM On Demand opportunity context 
(account - organization id, opportunity name, and so on), including the opportunity product lines 
during quote creation. Siebel CRM On Demand displays a summary page, listing the quotes 
associated with the opportunity. You can drill down on an individual quote, which launches a separate 
browser session in which you can update the Oracle E-Business Suite quote.

OrderableFlag CUSTOMER_ORDER_ENABLED_FLAG

PartNumber CONCATENATED_SEGMENTS

ProductName ITEM_SHORT_DESCIPTION(CONCATENATED_SEGMENTS||' - 
'||ORGANIZATION_CODE)

Table 17. Product Mappings

Attribute Names in Siebel 
CRM On Demand Attribute Names in Oracle E-Business Suite
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Displaying Oracle E-Business Suite Quotes Associated with a Siebel 
CRM On Demand Opportunity
From within the Siebel CRM On Demand Opportunity Detail page, you can review a listing of quotes 
associated with the opportunity by clicking a custom Web link. This opens an Oracle E-Business Suite 
page containing a summary table of quotes associated with the opportunity. You can drill down on 
an individual quote, which launches a separate browser session in which you can update the Oracle 
E-Business Suite quote.

Displaying Oracle E-Business Suite Quotes Associated with a Siebel 
CRM On Demand Customer Account
From within the Siebel CRM On Demand Account Detail page, you can review a listing of quotes 
associated with the customer account by clicking a custom Web link, which opens an Oracle 
E-Business Suite page containing a summary table of quotes associated with the Siebel CRM On 
Demand customer account within an Siebel CRM On Demand custom Web tab. You can drill down on 
an individual quote, which launches a separate browser session in which you can update the Oracle 
E-Business Suite quote.

Integration Overview
The Siebel CRM On Demand Integration Pack for Oracle E-Business Suite is enabled using Siebel CRM 
On Demand Custom Web Tabs, Custom Web Links, and Web Services infrastructure with the Oracle 
E-Business Suite BPEL Process Manager. The resulting integration functionality enables the following:

■ Ability to create an Oracle E-Business Suite quote from an Siebel CRM On Demand opportunity

■ Ability to display Oracle E-Business Suite quotes associated with an Siebel CRM On Demand 
opportunity

■ Ability to display all Oracle E-Business Suite quotes associated with an Siebel CRM On Demand 
Customer account

■ Ability to display all quotes on which the user is the Primary Sales Rep
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Figure 14 illustrates this functionality.

Creating Oracle E-Business Suite Quotes from Siebel CRM On Demand 
Opportunities
From within the Siebel CRM On Demand Opportunity Detail page, a user can initiate the creation of 
a quote by clicking a custom Web link, which creates an Oracle E-Business Suite quote as a 
background process. Users are directed to a summary page, listing the quotes associated with the 
opportunity within an Siebel CRM On Demand custom Web tab. Users are able to drill down on an 
individual quote, which launches a separate browser session in which the user can update the Oracle 
E-Business Suite quote.

Basic information from the opportunity (customer account, customer contact, product information) 
is carried forward to the newly created quote. Information such as sales credit, sales-team 
integration, and so on are not synchronized.

Figure 14. Integration functionality
Siebel CRM On Demand Integration Pack for Oracle E-Business Suite 
Implementation Guide  

88 



About Integrating Customer Data, Products, and Quotes ■ Quote Integration
About Siebel CRM On Demand Opportunity Context to Be Carried 
Forward to Oracle E-Business Suite Quote
The following Siebel CRM On Demand opportunity contexts are passed to the Oracle E-Business Suite 
quote header to ensure the quote is created appropriately:

■ Siebel CRM On Demand account > Oracle E-Business Suite Customer Name

■ Siebel CRM On Demand Primary Opportunity Contact > Oracle E-Business Suite Contact Name

■ Siebel CRM On Demand Opportunity Name > Oracle E-Business Suite Quote Name

■ Siebel CRM On Demand Product Lines > Oracle E-Business Suite Quote Lines

When creating or updating the opportunity, if these contexts do not exist in the Siebel CRM On 
Demand opportunity and the create quote process is initiated, then no context is passed to Oracle 
E-Business Suite Quoting, and the quote creation process continues uninterrupted.

Siebel CRM On Demand Opportunity Product Lines Must Exist on the 
Quoting Price List
All products on the Siebel CRM On Demand opportunity must exist on the Oracle E-Business Suite 
default price list during quote creation to be included in the quote. If one of the opportunity product 
lines does not exist on the default price list, the quote is not created and a pricing (QP) error is 
thrown to the end user.

Siebel CRM On Demand Opportunity Product Lines Must Belong to 
Valid Operating Unit
All products on the Siebel CRM On Demand opportunity must be associated with the logged-in user's 
item validation organization operating unit (Org_ID) to be included in the quote during conversion. 
Items that do not belong to the user's associated Item Validation Org are not added to the quote, 
and no warning or error messages are displayed.

Product Quantity and Product Unit of Measure
The quantity associated with the product line on the Siebel CRM On Demand opportunity is passed 
to the corresponding line on the Oracle E-Business Suite quote upon conversion. The Unit of Measure 
(UOM) for the product line is derived from the item's Primary UOM on the Oracle E-Business Suite 
product master.

Account Defaulting on Opportunity-to-Quote Conversion
Upon converting the Siebel CRM On Demand opportunity to an Oracle E-Business Suite quote, the 
associated customer account (Account Number field on the Oracle E-Business Suite Quoting General/
Overview page) is displayed by default only if one account number exists for the customer. If multiple 
accounts exist for the customer, no account is displayed by default. The user can then go to the Quote 
General page and select the valid account for the customer quote.
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Quote Name Derived from the Opportunity Name
During the quote creation process, the newly created quote name is derived from the Siebel CRM On 
Demand opportunity name. The Siebel CRM On Demand opportunity name is not displayed on the 
Opportunity Name field within the Oracle E-Business Suite quote.

Display Oracle E-Business Suite Quotes Associated with a Siebel CRM 
On Demand Opportunity
From within the Siebel CRM On Demand Opportunity Detail page, a user can review a listing of all 
quotes associated with the opportunity by clicking a custom Web link. This link opens an Oracle 
E-Business Suite page containing a summary table of all quotes associated with the opportunity 
within an Siebel CRM On Demand custom Web tab. The quote summary table consists of the following 
fixed columns:

■ Quote Name (Hyperlink)

■ Quote Number

■ Primary Sales Person

■ Status

■ Creation Date

■ Expiration Date

■ Amount

The table is sorted by the last-update date for the quotes. The quote listing page has the Siebel CRM 
On Demand look-and-feel. Users can drill down on an individual quote, which launches a separate 
browser session in which the user can update the Oracle E-Business Suite quote.

Display Oracle E-Business Suite Quotes Associated with a Siebel CRM 
On Demand Customer Account
From within the Siebel CRM On Demand Account Detail page, a user can review a listing of all quotes 
associated with the customer account by clicking a custom Web link. This link opens an Oracle 
E-Business Suite page containing a summary table of quotes associated with the Siebel CRM On 
Demand customer account within a Siebel CRM On Demand custom Web tab.

The table is sorted by the last-update date for the quotes. The quote listing page has the Siebel CRM 
On Demand look-and-feel. Users can drill down on an individual quote, which launches a separate 
browser session in which the user can update the Oracle E-Business Suite quote.

Ability to Distinguish Between Quotes Created from Siebel CRM On 
Demand and Oracle E-Business Suite
Quotes generated from a Siebel CRM On Demand opportunity can be identified by displaying the 
Quote Overview page and checking the Opportunity Source field for the value Siebel CRM On 
Demand. The Opportunity Source field replaces the Opportunity Name field on both the Quote 
Overview page and the Quote General pages.
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Quotes created from an Siebel CRM On Demand opportunity cannot be associated with an Oracle 
E-Business Suite opportunity, because the Opportunity Name field and LOV are replaced by the 
Opportunity Source field. Quotes created directly from Oracle E-Business Suite (either standalone or 
as part of the Oracle E-Business Suite Opportunity-to-Quote flow) have the Opportunity Name field 
and LOV.

Ability to Distinguish Orders Originating from a Siebel CRM On 
Demand Opportunity
Orders originating from an Siebel CRM On Demand opportunity are marked as such. Open the Sales 
Order form within Order Management and check the Order Source Reference field. Orders originating 
from Siebel CRM On Demand have a value of SEBL_<<Siebel Opportunity ID>> in that field.

Quote Listing within the Siebel CRM On Demand Custom Web Tab
You can review all quotes for which they are specified as the Primary Sales Rep, by clicking a custom 
Web tab, which directs them to a quote listing page. This same custom tab displays the quotes 
associated with the opportunities and accounts, based on the page (Account or Opportunity Detail 
page) from which you were directed.

The quotes listed are bound by a time parameter (number of days) within the invoking URL that 
dictates the number of quotes returned. For example, a time parameter set to 120 days returns 
quotes created within the last 120 days. If no time parameter is specified, the default is 30 days.

The Quote summary table consists of the following fixed columns:

■ Quote Name (Hyperlink)

■ Quote Number

■ Customer Name

■ Contact Name

■ Account Number

■ Expiration Date

■ Status

■ Amount

The table is sorted by the last-update date for the quotes. The quote listing page has the Siebel CRM 
On Demand look-and-feel. Users can drill down on an individual quote, which launches a separate 
browser session in which a user can update the Oracle E-Business Suite quote.

Error Handling During Quote Conversion
If an error occurs during the Siebel CRM On Demand opportunity to Oracle E-Business Suite quote 
conversion process, the errors are logged in the middle-tier, and the following message is displayed 
to the end-user:

“Quote conversion failed. Please contact your system administrator.”
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About Integrating Customer Data, Products, and Quotes ■ Quote Integration
The message displays within the Siebel CRM On Demand custom Web tab on an Oracle E-Business 
Suite page.
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6 Troubleshooting
This chapter describes troubleshooting and error message information for the Siebel CRM On 
Demand Integration Pack for Oracle E-Business Suite. It contains the following sections:

■ Error Messages on page 93

■ Error Logging Database on page 93

■ Resolving Errors on page 94

■ NoClassDefFound Error on BPEL Process Auto-Deployment on page 96

■ Siebel CRM On Demand to Oracle E-Business Suite Address Synchronization Failures on page 96

Error Messages
All error messages that are displayed follow this format:

CRMInteg - yyy- xxxxx

where:

■ yyy indicates the Siebel CRM On Demand Integration Pack for Oracle E-Business Suite. 

■ xxxxx indicates an error message number. Numbers between 100 and 49,999 are fatal errors.

Error Logging Database
Siebel CRM On Demand Integration Pack for Oracle E-Business Suite stores errors in an error logging 
database. Error logs are stored in a database table for ease of retrieval and analysis. For more 
information on this database read “Configuring the Error Logging Database” on page 25. Table 18 lists 
the columns in the table.

Table 18. Columns in the Error Log File 

Column Name Data Type Nullable Column Description

CALLINGPROCESSNAME VARCHAR2(60) No Stores the calling process name

CALLINGPROCESSINSTAN
CEID

VARCHAR2(10) No Stores the calling instance name

FAULTTEXT VARCHAR2(1000) Yes Stores the Fault Text

FAULTSTACK VARCHAR2(1000) Yes Stores the stack Trace
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Troubleshooting ■ Resolving Errors
Table 19 lists the error messages used in Siebel CRM On Demand Integration Pack for Oracle 
E-Business Suite.

Resolving Errors
During Siebel CRM On Demand maintenance, if the Siebel CRM On Demand server is shut down, the 
polling process instances has be purged and restarted after the Siebel CRM On Demand server is 
restarted.

FAULTCONTEXT VARCHAR2(200) Yes Stores the Fault Context

PROCESSINPUTPAYLOAD BLOB Yes Stores the Entire Fault Payload

Table 19. Error Messages in Siebel CRM On Demand Integration Pack for Oracle E-Business Suite

Error Code Error Message Text

1 Encountered RemoteFault at 
CRMIntegSubscribeToCreateProductEBS11i10ToSEBL782

2 Encountered UnknownFault at 
CRMIntegSubscribeToCreateProductEBS11i10ToSEBL782

3 Insufficient inputs to process ProductCreate event

4 Encountered RemoteFault at 
CRMIntegSubscribeToUpdateProductEBS11i10ToSEBL782

5 Encountered unknown fault in 
CRMIntegSubscribeToUpdateProductEBS11i10ToSEBL782

6 Insufficient inputs to process ProductUpdate event

7 Encountered RemoteFault at 
CRMIntegSubscribeToBulkloadProductEBS11i10ToSEBL782

8 Encountered UnknownFault at 
CRMIntegSubscribeToBulkloadProductEBS11i10ToSEBL782

9 Insufficient inputs to process Product Bulkload event

10 Encountered RemoteFault in process CRMIntegSyncProductEBS11i10ToSEBL782

11 Encountered unknown fault in CRMIntegSyncProductEBS11i10ToSEBL782

12 Error during bulk data fetch for ProductSync

13 Error while fetching single item data in ProductSync process

14 Incorrect EventName passed to Product Sync process

Table 18. Columns in the Error Log File 

Column Name Data Type Nullable Column Description
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Troubleshooting ■ Resolving Errors
In the case of a polling process (CRMIntegSEBLODPollingSchedulerAsync) failure, perform the 
following:

1 Purge all instances:

a From the Oracle SOA Suite main page click the link for BPEL Control.

b Log in as an administrative user.

c Click Instances tab.

d Click Purge All Instances.

e Click Delete All Instances.

f In the warning message, click Delete All Instances.

This step stops the Siebel CRM On Demand Polling process. When purging is complete, restart 
the CRMIntegSEBLODPollingSchedulerAsync process.

2 Clear the WSDL cache:

a Log in to BPEL control as an administrative user.

b Click the BPEL Processes tab.

c Click the Clear WSDL Cache link.

3 Clear LastPollingWindowEnd from the od_config table.

a Log in to the middle-tier database with the account used to create od_config table.

b Execute the following SQL command:

delete from od_config
where Name = 'LastPollingWindowEnd';

4 Restart SOA:

a Log in to Application Server Control as an administrative user.

b Click Expand All Application Servers

c Check the top level check box next to the link for middle-tier host (for example: 
ap6002gns.ap6002gns) and where the Type = Application Server.

d Click Restart > Yes.

5 Restart polling:

a From the Oracle SOA Suite main page click the link for BPEL Control.

b Log in as an administrative user.

c Click BPEL Processes tab.

d Click CRMIntegSEBLODPollingSchedulerAsync process.

e Click Initiate to start this process.

f Provide the following values to the process:

❏ Unit = S      (for seconds)
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Troubleshooting ■ NoClassDefFound Error on BPEL Process Auto-Deployment
❏ Frequency = 3600      (for one hour)

g WindowStart = (leave this blank to force polling to pick up from where it left off)

h Click Post XML Message.

i Click the Instances tab to check if the instances are getting polled.

NoClassDefFound Error on BPEL Process 
Auto-Deployment
If you receive a NoClassDefFound Error upon running ANT for the auto-deployment of BPEL 
processes, this may be related to multiple versions of ANT installed on your SOA Server. One version 
is likely configured for System Wide Installation and other for the current User Login. To correct the 
NoClassDefFound Error, run ANT with the noconfig option:

$ ANT --noconfig

Siebel CRM On Demand to Oracle E-
Business Suite Address Synchronization 
Failures
If you notice that updates to address details on the Account and Contact records do not propagate 
from Siebel CRM On Demand to the Oracle E-Business Suite this may be related to the number of 
countries supported in Siebel CRM On Demand, that do not exist in the Oracle E-Business Suite. If a 
user specifies a country that exists in Siebel CRM On Demand and does not exist in the Oracle E-
Business Suite, the entire address does not synchronize. Make sure that the country lists in both 
applications match.
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